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About Adobe® Reader®

Note:
Instructions in this user guide are based on the use of Adobe Reader version 6.0, a 
newer version of the Adobe Acrobat® Reader software.

You must have Adobe Reader to view and print this document. Adobe Reader can 
be downloaded free of charge from the Adobe Web site by visiting: 
http://www.adobe.com/products/acrobat/readstep2.html
Follow the instructions at the site for installing this software.

You can view the User Guide document on the CLEC Online Web site, or you can 
download and store it on your PC. You’ll need approximately 3 megabytes of 
storage space to do so. Storing the user guide on your hard drive gives you access 
to the Adobe Reader menus, including the Help menu, Reader Online Guide 
option. These files come with the Adobe Reader to assist you in using the various 
options that Adobe offers with the Reader software.

If you have any questions or problems with this document, please contact the 
IS Call Center at 314-235-7225.
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Opening the LEX User Guide
You can access the LEX User Guide using one of two resources:

 LEX Online Help: You can also access the current version of the LEX User 
Guide through the online help built into the LEX application. This allows you 
to quickly access the most up-to-date information.

 CLEC Online Web site: The CLEC Handbook section of the CLEC Online 
Web site provides many instructional documents and reference materials, 
including the LEX User Guide. Past and current versions are available. You 
choose the version to review.

Opening the guide using the LEX Online Help system

For additional information about LEX online help, see the section LEX Online 
Help in Chapter 2, Introduction.

1. From the Help menu, select Help Topics to open the online help system.

User Guide
button
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2. Click the User Guide button, depicted by the book at the top of the 
window.
The current version of the LEX User Guide is opened in Adobe® Reader in the 
main panel of the help system.

Opening the guide using the CLEC Online Web site

1. Using your Web browser, open the CLEC Online Web Site, located at 
https://clec.att.com/clec.

2. In the button menu on the left side of the window, click CLEC 
Handbook.

3. Select the Handbook option for your state. 

4. Select User Guides/Tech Pubs, Ordering, Local Service Request 
Exchange (LEX). 

5. Click the current User Guide you want to review.
The file will open in Adobe® Reader.
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Storing the LEX User Guide on your hard drive

Note:
To maintain the most current user information, delete any LEX User Guide that 
was previously saved on your hard drive and download a new guide with each 
new LEX version.

1. Open the version of the LEX User Guide you want to save to your hard 
drive using one of the two methods described in Opening the LEX User 
Guide. 
The file will open in Adobe® Reader®, as depicted in the following illustration.

3. Click the floppy disk icon in the Adobe Reader toolbar above the 
document. 
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Clicking the floppy disk icon opens the Save a Copy dialog box.

4. In the Save a Copy dialog box, name the document and click Save. 
This places the document as an icon on your desktop. 

5. To access the document, double-click the icon on your desktop.

This Adobe icon is labeled on your 
desktop with the user guide name.
Proprietary - Not for use or d
reproduce, copy, and distribute 
of this AT&T Operational Supp
Resale Agreement between the C
© 2002-2006. AT&T Knowled
isclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
the information solely for internal use in training employees to utilize the capabilities
ort System (OSS) in accordance with the OSS provisions of the Interconnection or
LEC and AT&T Inc. Additional or external use is strictly prohibited. 

ge Ventures. ALL RIGHTS RESERVED. 

v



Storing, Navigating, and Printing Your User Guide
Navigating tips for this document

Viewing the document

The display properties of your monitor must be set to a minimum of 600 x 800 
pixels for the display area. If your monitor’s display area is set to a lower 
resolution, such as 480 x 640 pixels, or you operate a laptop, then you may 
frequently need to use the zoom tool.

Depending on your PC’s display capabilities, the graphics in this document are 
best viewed at a 100-percent zoom factor. To set the zoom factor, click the drop-
down arrow next to the percentage number on the view toolbar, usually at the top 
of your screen. 

Page numbers

The user guide pages are numbered according to chapter number and page 
number. Page numbers appear in the bottom corner of each page. You’ll also find 
the page number of the page you’re viewing in the status bar at the bottom of the 
Adobe Reader window, as pictured below. 

In the status bar, the user guide page number is followed by a range in 
parentheses. The first number in the range is the sequential position of the page in 
the document, without regard to chapter. The second number indicates the total 
number of pages in the document. So, in the example above, page 1.1 is the 29th 
sequential page in a document that contains 314 pages. You can go to or print a 
specific page in the document by referencing its user guide page number (e.g., 
1.1) or its sequential page number (e.g., 29). Adobe Reader recognizes both page 
number formats.

Click the arrow to select a 
view factor.

View factor display.

Click the + button to increase the view factor and magnify the display. 
Click the - button to decrease the view factor.

Sequential position of page and total 
of pages in document

Page number with chapter 
and page reference
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Bookmarks

The bookmarks in this document are the same as those displayed in the Table of 
Contents. You can open the bookmarks by clicking the View menu, Navigation 
Tabs, Bookmarks option. Clicking a bookmark opens that page in the document. 
The bookmarks are in levels. Click the plus signs (+) to the left of bookmarks to 
open levels to reveal further related bookmarks.

Links

In the Table of Contents and the Index, you will find each item is a 
hyperlink that takes you to the referenced text. Click the Tools menu, Basic, 
Hand Tool option to activate the Hand tool, or click the Hand tool on the toolbar. 
Using the Hand tool, move it until the hand changes to a pointing finger, then 
click. The document will open to the page where the referenced text is located. 

Additional viewing options

You may view the document full screen without toolbars. If you use a 14- or 15-
inch monitor, this viewing option allows you to increase the viewing size of the 
document. To view full size, click the Window menu, Full Screen View option. 
Use your Page Up, Page Down, End, and Home keys for navigating the 
document. To return to the regular view, press your Esc key.

Using the Search option
You can search for words, abbreviations, or phrases using the Search option.

1. Click the Edit menu, then the Search option, or click the Search button 
on the toolbar.
The Search tab opens on the right side of the window.
Proprietary - Not for use or disclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities
of this AT&T Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and AT&T Inc. Additional or external use is strictly prohibited. 
© 2002-2006. AT&T Knowledge Ventures. ALL RIGHTS RESERVED. 

vii



Storing, Navigating, and Printing Your User Guide
2. Type the word or phrase that you want to locate and check any of the 
qualifiers. Then, click Search.
Matches found are listed in the Results box at the bottom of the Search tab. 

3. Click a result to view the corresponding page in the document.

Printing this document

1. From the File menu, select Print, or click the Print button. 
The Print dialog opens with your default printer selected.

2. If you do not want to print to the default printer, select a different one 
from the Name drop-down list.

3. In Print Range, select all pages of the user guide, the current page, or a 
range of pages. If you want to print a page range, type the starting and 
ending page numbers of the pages you want.

4. If you want to print more than one copy, indicate the number of copies 
in the Copies box.

Note:
Additional print options may be available to you. The options available vary from 
printer to printer.

5. Click OK to begin printing the document at the selected printer.
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Guide

This chapter describes the
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user guide and directs you to
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assist you in processing LSRs.
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About This Guide
Purpose 1
Purpose

The purpose of the guide is to assist you in learning to use the Local Service 
Request Exchange (LEX) application to process Local Service Requests (LSRs). 
Both experienced and inexperienced users can use it. New users may want to read 
the entire manual; experienced users may just need to look up specific 
functionality using the comprehensive index.

Throughout the guide, you’ll find illustrations of LEX data-entry areas. These 
illustrations are intended to help you learn how to use the LEX application and to 
demonstrate how to perform LEX procedures. For business rules associated with 
using LEX, consult the most current AT&T Local Service Ordering Requirements 
(LSOR) for business requirements.

Note:
AT&T regularly publishes Accessible Letters to provide information about LEX 
and other AT&T OSS applications. Information in Accessible Letters may super-
sede the content of this User Guide, even when distributed after the issue date of 
this Guide. Accessible Letters are available on the CLEC Online Web site.
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Organization

This User Guide is divided into the following parts:

Revision History
Provides details on all changes and additions to the user guide since the last 
update.

Chapter 1, About This Guide
Explains the purpose of this guide, details its organization; discusses any special 
notes, warnings, or conventions; and directs you to related information that will 
aid you in processing LSRs.

Chapter 2, Introduction
Discusses LEX and its installation requirements, how to connect to LEX, what the 
system hours and availability are, specific questions about Microsoft Windows®, 
and procedures for accessing LEX’s online help.

Chapter 3, Getting Started
Discusses the Toolbar, logging on and logging off the Toolbar and LEX, and LEX 
application’s graphical user interface (GUI).

Chapter 4, Pre-Order Integration
Discusses the interaction of Verigate (Pre-Order inquiries) during the create LSR 
process within LEX.

Chapter 5, Processing Local Service Requests
Provides you with step-by-step task-based instructions to perform procedures in 
LEX (e.g., Copying LSRs).

Chapter 6, Bulk Order Processing
Discusses the Bulk Order process for the AT&T Southeast Region.

Chapter 7, Data Reports
Explains how to generate reports using LEX and describes the selection criteria 
and the content provided with each report.
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Appendix A, Glossary
Defines many of the terms used in LEX’s application, online help, or this guide 
with which you may not be familiar.

Appendix B, Administrator IDs
Explains how to obtain an Administrator ID and details how to reassign LSRs 
from one user ID to another.

Appendix C, CLEC Profile Utility
Discusses the CLEC Profile Utility to allow information associated with a Com-
pany Code to be updated by the user.

Appendix D, LEX NPA Split Conversions
Provides details relevant to database conversions for NPA splits.

Appendix E, LEX Forms
Provides illustrations and descriptions of all LEX forms, including service forms 
and notifications.

The Index at the end of this guide helps you locate information which you may 
have trouble finding. An effort was made to include several different index entries 
for each section (e.g., Copying LSRs is indexed under both “LSRs, copying” and 
“Copying LSRs”). By scanning both the Index and Table of Contents you can 
familiarize yourself with the documentation available when you begin using LEX.
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Conventions Used in This Guide

This user guide is intended to provide the information that you need to effectively 
submit LSRs using the LEX system. Information is presented in an easy-to-read 
format using predefined information types—such as steps, notes, and warnings— 
and conventions designed to clarify meaning and foster understanding. 

Among these conventions, the LEX application and this user guide, for the 
convenience of discussion, refer to certain AT&T incumbent local exchange 
companies (ILECs) using pseudonyms when referring to them collectively:

Other conventions employed throughout this user guide include:

 Keyboard keys and the names of LEX icons, fields, windows, folders, tabs, 
buttons, menus, and options appear in bold, sans serif type.

 Tasks you perform using LEX are presented as numbered, step-by-step 
procedures.

 Steps in task-based procedures are in bold, sans serif type.

 Procedures use illustrations to depict what you will see in LEX. Illustrations 
always follow the steps with which they correspond.

AT&T West Region • Nevada Bell Telephone Company, d/b/a AT&T Nevada
• Pacific Bell Telephone Company, d/b/a AT&T California

AT&T Midwest 
Region

• Illinois Bell Telephone Company, d/b/a AT&T Illinois
• Indiana Bell Telephone Company Incorporated, d/b/a 

AT&T Indiana
• Michigan Bell Telephone Company, d/b/a AT&T Michigan
• Ohio Bell Telephone Company, d/b/a AT&T Ohio
• Wisconsin Bell, Inc. d/b/a AT&T Wisconsin

AT&T Southwest 
Region

• Southwestern Bell Telephone, L.P., d/b/a AT&T Oklahoma,
AT&T Missouri, AT&T Kansas, AT&T Arkansas and 
AT&T Texas

AT&T Southeast 
Region

• AT&T Alabama, AT&T Florida, AT&T Georgia, 
AT&T Kentucky, AT&T Louisiana, AT&T Mississippi, 
AT&T North Carolina, AT&T South Carolina, and 
AT&T Tennessee, collectively referred to as the “AT&T
Southeast Region”.
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 Information that is of special significance to a topic, but is nonessential is 
presented as notes in italic type. Notes are preceded by this icon:

 Information critical to the operation of the system or that alerts you to 
potential problems is presented as warnings in bold, italic type. Warnings are 
preceded by this icon: 

 Page numbers are comprised of the chapter number followed by a period and 
the number of the page within the chapter. For example, this page is 1.5 
because it is page 5 of chapter 1.

 The terms LSR Workspace, LSR Tree, form, section, tab, dialog screen, and 
dialog are used to describe data-entry areas and screen organization. For 
descriptions of these data-entry areas, see the sections LSR Tree and LSR 
Workspace in Chapter 3, Getting Started.
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Questions?
 Please direct all questions about specific order requests to your Service 

Representative in the Local Service Center (LSC). 

 Direct all CLEC inquiries involving ordering activity, system navigation, and 
business rules via LEX to the Mechanized Customer Production Support 
Center (MCPSC) at 877-681-2271. When calling, select Option 2. Then, on 
the ACD menu choose the region in which you are doing business.

 All system questions (i.e., access trouble, user ID and password assistance, 
problems with your remote connections, and so forth) should be directed to 
the IS Call Center at 314-235-7225.

 Questions can also be directed to your Account Manager and OSS Support 
Manager.

Additional resources
The following additional resources are available to assist you in issuing LSRs to 
an AT&T Incumbent Local Exchange Carrier:

 Local Service Ordering Requirements (LSOR)
Contains Local Service Requests (LSR) field definitions and usage 
requirements.

 CLEC Online Web Site
Located at https://clec.att.com/clec, this Web site provides online access to 
the LEX User Guide and the LSOR.
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 Accessible Letters
Located on the CLEC Online Web site, these documents provide the most 
current information about business rules and changes to LEX and other AT&T 
OSS applications. In some cases, these documents may supersede information 
found in this User Guide.

Note:
“Telcordia® and Common Language® are registered trademarks of iconectiv, 
CLCI, CLEI, CLFI, CLLI, USOC, FID, NC, NCI, and NC/NCI, are trademarks of 
Telcordia Technologies, Inc. The Common Language codes identified herein are 
the proprietary information of Telcordia Technologies, Inc. dba as iconectiv 
(“iconectiv”) and are licensed to AT&T Inc. The Common Language codes are 
provided herein solely for the purpose of this Accessible Letter and may not be 
reproduced, stored, or used for any other purpose without the express, written 
consent of iconectiv.”
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reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities
of this AT&T Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and AT&T Inc. Additional or external use is strictly prohibited. 
© 2002-2006. AT&T Knowledge Ventures. ALL RIGHTS RESERVED. 

1.7



About This Guide
Related Information1
Proprietary - Not for use or disclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities
of this AT&T Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and AT&T Inc. Additional or external use is strictly prohibited. 
© 2002-2006. AT&T Knowledge Ventures. ALL RIGHTS RESERVED. 

1.8



Introduction
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information about LEX and the
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Introduction
Overview 2
Overview

Affiliate companies of AT&T Inc. offer competitive local exchange carriers 
(CLECs) an online system to create and submit Local Service Requests (LSRs). 
That system is the Lsr EXchange System or LEX. A CLEC can order both Resale 
and Unbundled Network Element (UNE) services through LEX.

Today, online capture of LSRs simply makes good business sense. It creates more 
accurate documents and shortens the implementation time for orders. AT&T 
undertook this software development because some CLECs do not have the 
information systems infrastructure to do it on their own. LEX can also be an 
interim solution for CLECs who are developing their own software.

LEX uses graphical user interface (GUI) windows modeled after existing LSR 
forms. For detailed information about form and field usage, refer to your Local 
Service Ordering Requirements (LSOR).

While LEX retains all the information from the existing paper LSR forms, that 
information extends over several onscreen data-entry areas, which are referred to 
as forms and sections. For example, individual sections exist for the detail, 
service, and end user portions of an LSR. You can view forms and sections in the 
LSR Workspace by clicking them in the LSR Tree.

LEX is part of the AT&T Operational Support Systems (OSSs). As such, it works 
together with other components to distribute service requests to the necessary 
business units, coordinates installation and provisioning of activities, and provides 
tracking throughout the service order process. LEX sends the LSRs you’ve issued 
to the downstream AT&T OSSs.
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System Requirements

LEX is a browser-based application designed for use in the Windows® 
environment. Launched from the AT&T Web Toolbar, LEX is accessible through 
secure HTTP (HyperText Transport Protocol) over the extranet direct LAN (Local 
Area Network) or dial-up connection and the Internet.

Your Web browser must be set to check for new versions of stored pages at every 
visit to a page. Instructions for setting this option are provided in Browser Tips, 
Checking for newer versions of stored pages. For more information about Internet 
Explorer versions and 128-bit encryption, visit the Microsoft Internet Explorer 
Download Web page: 
http://www.microsoft.com/Windows/ie/downloads/recommended/128bit/
default.asp

Specific versions are required for LEX to operate properly. For a complete list of 
supported software versions, refer to the table in Appendix 6 of the Competitive 
Local Exchange Carrier Operations Support System Interconnection Procedures, 
located on the CLEC Online Web site. Follow the steps below to access the 
document:

1. Using your Web browser, open the CLEC Online Web Site, located at 
https://clec.att.com/clec. 

2. In the button menu on the left side of the window, click CLEC 
Handbook.

3. Select the Handbook option for your state. 

4. From the menu, select OSS, then Operations Support Systems. 

5. In the OSS Documentation list, click General. 

6. Click AT&T OSS Interconnection Procedures to open the document. 
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Connecting to LEX

Before you as a CLEC can access the OSSs of any AT&T Incumbent Local 
Exchange Carrier (ILEC) company, you must complete a 21-State CLEC Profile. 
Your Account Manager will supply you with this form. After completing the 
form, return it to your Account Manager, who will then authorize access by 
signing the form and forwarding it to the Information Services Call Center (IS 
Call Center). Your Account Manager will also facilitate the assignment of your 
user ID and password.

After you’ve been assigned a user ID and password, you will be able to connect to 
LEX through the Toolbar using the following URL (Uniform Resource Locator), 
commonly known as Internet address. Your Account Manager can instruct you 
about dial-up and direct-connect access alternatives.

Contact your Account Manager for any issues encountered during the logon 
procedure.

Access method URL

If you’re reaching the AT&T net-
work via one of the AT&T RAFs 
(Remote Access Facility) or via 
the internet:

https://osstoolbar.att.com
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Password Procedures

The AT&T Toolbar serves as a point of “common access” to AT&T applications. 
After entering your user id and password to logon to the Toolbar, you may access 
all applications on the Toolbar without logging on again. In order to obtain a user 
id and password, contact AT&T Customer Support and request a Toolbar User Id 
Request Form.

Logging onto the Toolbar
In order to access the Toolbar through your web browser, go to the web address 
provided to you by your account representative. When the logon screen is 
displayed, type in your user id and password. For security reasons the password is 
not displayed on the screen. Select the OK button to initiate the logon process.

If you enter the password incorrectly, a message will be displayed and you may 
try again. If three (3) consecutive attempts fail, then the Toolbar exits 
automatically and your user id will be revoked. If you do not remember your 
password, you may call the AT&T Customer Support group for assistance.

If your password has expired, a message will be displayed and the change 
password window will appear to allow you to change your password.

If your user id has been revoked, a message will be displayed and the Toolbar will 
exit. In this event, call the AT&T Customer Support group to have your user id 
reinstated.

After you have logged on successfully, a toolbar will be displayed with buttons for 
each AT&T application to which you have been granted access. On the main login 
page, you will be displayed application news items (if any) for each AT&T 
application to which you have been granted access. You will also be displayed 
system status items (if any) related to system availability, outages, etc.

Changing Password
The Change Password window is displayed at logon when your password has 
expired or when change password is selected from the Options menu. In order to 
change your password, enter your old password and then enter the new password 
twice in order to verify that it was entered as intended. For security reasons the 
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passwords will not be displayed on the screen. If an invalid password format is 
entered, a message will be displayed, and you may attempt to change your 
password again.

Password Format
 A valid password must be 6-8 characters in length and contain at least one 

letter.

 It must also contain at least one digit (0-9) in a position other than the first or 
last character; it may additionally contain a number in the first and/or the last 
position if desired.

 A valid password cannot contain a space or a tab character and may not be 
completely blank.

 It must not contain the user’s complete user id.

 The same character cannot occur in three consecutive positions in the 
password.

 The password must differ from the user id by at least three positions.

 The new password must differ from the previous password by at least two 
positions.

 Passwords may not be reused for at least six (6) months.

 A user cannot change their password within seven (7) days of the last change.

 The new password must not contain a sequence of three (3) or more 
characters from the previous password.

Expired Password
The Toolbar requires that you change your password at least once a month. If it 
has been at least 60 days since you changed your password, you will receive a 
message when you log in requesting that you change your password before 
continuing.

Revoked User ID
If you do not logon to the Toolbar for at least 90 days, your user id will be 
revoked. In this event, please call the AT&T Customer Support group to have your 
user id reinstated.
Proprietary - Not for use or disclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities
of this AT&T Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and AT&T Inc. Additional or external use is strictly prohibited. 
© 2002-2006. AT&T Knowledge Ventures. ALL RIGHTS RESERVED. 

2.5



Introduction
System Availability and Support2
System Availability and Support

Hours of Business
During the hours listed below, LEX is available for business. Each morning, LEX 
is unavailable while system maintenance is performed. On the first Sunday of 
each month, LEX will have an extended downtime for regular Toolbar 
maintenance.

Note:
Be sure to complete your work in LEX before system maintenance begins. LEX 
will log out all logged-in users during the maintenance period. If you are logged 
in during this time, you may lose unsaved work.

LEX Weekly Schedule LEX Hours - Central Time (CT)
AT&T 12 State

Monday through Friday 5:00 a.m. - 1:00 a.m. Next Day
Saturday 5:00 a.m. - 12:00 a.m. Midnight
Sunday 4:00 a.m. - 1:00 a.m. Monday
First Sunday of the Month 8:00 a.m. - 1:00 a.m. Monday

AT&T Southeast Region
Monday through Friday 3:00 a.m. - 12:00 a.m. Midnight
Saturday 3:00 a.m. - 9:00 p.m.
Sunday 9:00 a.m. - 11:00 p.m.

AT&T 21 State
Monday through Friday 3:00 a.m. - 1:00 a.m. Next Day
Saturday 3:00 a.m. - 12:00 a.m. Midnight
Sunday 4:00 a.m. - 1:00 a.m. Monday
First Sunday of the Month 8:00 a.m. - 1:00 a.m. Monday
Hours may vary due to holiday and other OSS availability issues. See “Holi-

day and other OSS availability” for more details.
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Note:
LEX Pre-Order issuing will be bound to Verigate, LASR availability and other 
back end systems.

CLECs will be able to create LSRs and launch the Verigate pre-order system, but 
any transaction done in the Verigate screens will be bound to its availability tim-
ings. Verigate will display messages to let the user know that the pre-order system 
is unavailable.

CLECs users will be able to issue but any transaction done in LASR will be bound 
to its availability timings, business as usual, transactions will be held until LASR 
is available.

To view a list of the business hours of other OSS applications, follow these steps:

1. Using your Web browser, open the CLEC Online Web Site, located at 
https://clec.att.com/clec. 

2. In the button menu on the left side of the window, click CLEC 
Handbook.

3. Click the Handbook option for your state. 

4. From the menu, select OSS, then Operations Support Systems.

5. In the OSS Documentation list, click Operating Hours.

6. Click OSS Hours of Operation to open the document. 
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IS Call Center
The IS Call Center is the single point of contact to assist in answering questions 
and resolving issues such as expired passwords, application and network 
problems, and the installation and configuration of software.

Mechanized Customer Production Support Center
The Mechanized Customer Production Support Center (MCPSC) assists CLECs 
with questions about order activity, system navigation, and business rules.

IS Call Center Contact Information 
Phone Number 314-235-7225
Fax Number 314-331-1577
Hours Monday through Friday

7:00 a.m. - 5:00 p.m. Central Time (CT)
Hours may vary due to holiday and other OSS availability issues. See “Holiday
and other OSS availability” for more details. Off-shift hours are covered by pager.

MCPSC Contact Information 
Phone Number 877-681-2271
Hours Monday through Friday

8:00 a.m. - 5:30 p.m. Central Time (CT)
Hours may vary due to holiday and other OSS availability issues. See “Holiday
and other OSS availability” for more details. Off-shift hours are covered by pager.
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Customer Care Center Responsibilities 

Are you unsure which AT&T Customer Care Center you should call? A document 
to help you decide is available on the CLEC Online Web site. This document 
describes the responsibilities of the IS Call Center, the Mechanized Customer 
Production Support Center, and the Local Service Center (LSC). Follow the steps 
below to access the document.

1. Visit CLEC Online at https://clec.att.com/clec.

2. From the button menu on the left side of the window, select Getting 
Started, then CLEC Customer Service Contacts.

3. Scroll to the section “Overview of the MCPSC, IS Call Center and LSC 
Customer Care Centers,” where you’ll find a link to the document.

Holiday and other OSS availability
The most up-to-date holiday and other OSS availability will be announced in 
CLEC accessible letters. It is also posted on the AT&T CLEC Online Web Site. 
Follow these steps to view the document that lists the hours when the OSS 
applications and Local Service Centers are available:

1. Using your Web browser, open the CLEC Online Web Site, located at 
https://clec.att.com/clec. 

2. In the button menu on the left side of the window, click CLEC 
Handbook.

3. Click the Handbook option for your state. 

4. From the menu, select OSS, then Operations Support Systems.

5. In the OSS Documentation list, click Operating Hours.

6. Click OSS Hours of Operation to open the document. 
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Graphical User Interface Tips

LEX, like other Web-based applications, is built upon the principles of Windows 
and GUI systems. Microsoft® Windows® is a Graphical User Interface (GUI), 
which means you can work with your computer by clicking buttons and dragging 
icons. You can also understand how the computer works by looking at its 
graphical display. 

In the Windows environment, applications and documents open in rectangular 
areas on the screen known as “windows.” Because LEX works under the 
Windows environment, it runs in a window opened by your Web browser, 
allowing you to switch back and forth between LEX and other applications. 
Another benefit of the Windows environment is that once you’ve learned how to 
work with menus and buttons in one Windows application, you can use that 
knowledge in LEX.

The LEX documentation assumes you have some familiarity with Microsoft® 
Windows®. The intention of this tips section is to cover a few basic principles. 
Please see the user guide or online help of your Microsoft Windows software for 
more detailed instructions and documentation.

Using the mouse
In Windows applications, you use your mouse to maneuver your pointer around 
the application. You may use your mouse to:

Your primary mouse button is the left button on your two-button mouse. If you 
are left-handed, you may switch your mouse buttons in Windows Control Panel 
and then move your mouse to the left side of your workstation.

Point Move the pointer to a specified place on your screen.
Click Press and release your mouse button.
Drag Hold down your mouse button, move the mouse while 

holding button down, then release the mouse button.
Double-click Press and release your mouse button twice in rapid 

succession.
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Your mouse pointer displays differently depending upon where it is in a window. 

Working with list boxes

Drop-down lists

In a list box, you enter information by selecting from a list of choices. In LEX, a 
list box is a field with a drop-down arrow attached that when clicked opens the 
list. It also represents an area containing many records that you may need to scroll 
through to view completely.

Fields that use drop-down list boxes have a downward-pointing arrow. When you 
click the arrow, known as the drop-down arrow, you can view the contents of the 
list box. The list box displays choices defined in the LEX database tables. By 
providing a list box, LEX enables you to scroll through a list of values and choose 
the correct value without having to remember what values go in specific fields.

Note:
In LEX, drop-down choices for fields which are not required include (BLANK) 
which allows you to “deselect” a value after one has already been selected.

Although you can scroll through a list of choices, you often know the information 
you want in the field. In this case, you want the quickest possible means of 
entering the information. Instead of clicking the drop-down arrow to open the list 
box, you can type directly into the field. As you type characters the list box 
scrolls. For example, if you want to select the state of Missouri from the list box, 
type M and the list box will scroll to Maine, the first state beginning with the letter 
M. Then, when you type M again, the list box scrolls to the next state beginning 

The standard selection pointer displays as an arrow 
pointing up and slightly to the left.

When you move your pointer close to the edge of 
the browser window or a column, it changes to a 
two-headed resize arrow.

A blinking I-beam indicates you’ve entered a text 
area, such as a field in the LSR Workspace of LEX, 
in which you can type or select text.

An hourglass denotes that the program is busy pro-
cessing data. 
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with M. Continue to type M and when the field displays Missouri, you can tab to 
the next field. This is particularly helpful on longer lookup fields where you only 
need to type your first character one or two times and the value you need will 
display.

List boxes
A second type of list box exists in LEX. It resembles a table or grid, providing 
tabular information. You can sort by the different columns in this type of list box. 
Clicking the up or down arrow beneath a column heading sorts the list-box items 
by the value for that column. For example, if you are searching for an LSR and 
you click the up arrow in the PON column, it will sort by PON in ascending order. 
Clicking the down arrow in the PON column heading sorts by PON in descending 
order. 

 

Entering dates
In LEX, fields you use to enter dates are displayed as three boxes: month (mm), 
day (dd), and year (yyyy). Each box is a drop-down list that provides date-
component selections. Using these boxes, select the month, day, and year of the 
date you need. All three boxes require a selection for a date to be valid. If any one 
date box is blank at the time the LSR is saved, that entire date field will be cleared, 
allowing you to correctly enter the date.

A LEX Date Field

Click the up arrow in a column 
header to sort in ascending order.

Click the down arrow to sort in 
descending order.

Calendar button

Month, Day, and Year 
drop-down lists
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You’ll notice when you click the year drop-down arrow, the field contains few 
values. It only provides year choices that are within the eligible date range, 
generally as much as two years in the past or two years in the future. For example, 
when you conduct a search based on an LSR’s Last Activity Date, you can only 
select the current year, the previous year, or the year two years before. 

When you move the cursor from any of the boxes in a date field, LEX checks that 
the date you selected is valid. To be valid, a date must be an actual calendar date 
and must also meet the requirements of the particular field you’re completing. 
Actual calendar dates are those in which the selected day exists in the selected 
month. For example, the dates February 30 and June 31 do not exist and are, 
therefore, invalid. Similarly, some fields prohibit past date. Therefore, in such 
fields, past dates are invalid. Should you select an invalid date, LEX will prompt 
you to choose a different date. To help you choose valid dates, date fields also 
provide an interactive calendar, which is described in the next section.

Calendar

Adjacent to each LEX date field is a calendar button. Clicking this button 
opens an online, interactive calendar you use to select dates. The calendar 

displays one month at a time. Select a month and year, or click the >> (Next 
Month) and << (Previous Month) buttons to see different months.

Selected date is 
highlighted.

Today’s date is 
displayed.

Ineligible dates are
crossed out.

Choose a month using
the drop-down list.

Choose a year using 
the drop-down list.

Click the Previous
Month button to go

back one month.

Click the Next Month 
button to go forward 
one month.

Click the Refresh Date button to return to 
the calendar page of the selected date.
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The calendar offers these interactive features:

 Today’s date is displayed at the bottom of the calendar.
Availability of this feature is dependent upon the version of Internet Explorer 
you’re using.

 The selected date is highlighted in yellow. 
When you open the calendar, any previously selected date is highlighted in 
yellow. If you have not yet selected a date, today’s date is highlighted.

 Ineligible dates are crossed out. 
These dates are invalid selections for the date field that is currently active. For 
example, you can conduct a search based on Last Activity Date, but Last 
Activity Date must be today’s date or a past date. This is because it is 
impossible for an LSR to have past activity that occurs in the future. For this 
reason, all dates beyond today’s date are crossed out.

 A full month is displayed on each page of the calendar.
Change the displayed month by selecting a month and year from the drop-
down lists at the top of the calendar. Alternatively, you can page through the 
calendar one page at a time by clicking the >> (Next Month) and << 
(Previous Month) buttons. If your mouse is equipped with a scroll wheel, you 
can page through the calendar by positioning the cursor over the month drop-
list and rolling the scroll wheel.

 The Refresh Date button returns the calendar to the selected date.
After you’ve opened the calendar and viewed different pages, you can return 
to the page of the selected date by clicking <> (Refresh Date) at the top of the 
calendar. If you have not yet selected a date, you return to today’s date.

Using the calendar to enter a date

1. Click the calendar button adjacent to the date field to be completed.
The calendar opens. The highlighted date is today’s date or the date that was 
previously entered in the date field.

2. Find the date.
Choose a month and year by selecting from the drop-down lists at the top of the 
calendar or by turning the calendar pages, clicking the arrow buttons until you 
reach the correct month and year.

3. Click the desired date to highlight and select it.

4. Click the X button on the calendar to close it and place the selected 
date in the date field.     
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Entering telephone numbers
Like date fields, fields you use to enter telephone numbers are typically displayed 
as three boxes in LEX. Telephone number fields that accept ranges appear as four 
boxes. In each box, you type the correct numbers and other characters, if 
applicable. Some telephone number fields accept only numbers. Entering letters 
and other non-numeric characters in these fields will produce a data validation 
message when you exit the telephone number field.

As you type in each telephone number box, LEX counts the characters you type. It 
automatically advances the cursor to the next box when the box that you’re 
completing reaches its maximum length. For example, in the NPA box, you can 
type three characters. Upon typing the third character, LEX advances the cursor to 
the NXX box. In the case of the final telephone number box, LEX will not advance 
to the next field when its maximum length is reached. Instead, the cursor remains 
in the last box until you press Tab to advance to the next field. 

Example LEX Telephone Number Fields
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Using a check box
The use of a check box is an alternative to a drop down list that would contain two 
values, “Yes” and “Blank”. If the check box is clicked, a check mark will appear 
within the box, which equates to a value of “Yes”. If the check box is not clicked, 
this equates to a blank and no value is attached to that field. 

Example of a Check Box: Example of a Check Box checked:
2
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Browser Tips

LEX documentation assumes you have some basic knowledge of the Internet. The 
intention of this tips section is to cover a few fundamental principles. It also 
includes information about settings that provide optimum LEX performance. For 
more detailed instructions and documentation, please refer to your Web browser’s 
online help.

Browser compatibility
To access a Web site or Web-based application on the Internet or the World Wide 
Web, you must have a browser. A browser is software that interprets HTML 
(hypertext markup language) code. It retrieves the content of a Web site, 
downloads it to your PC for translation, and sends your responses back to the Web 
site’s server.

Many browsers are available, each providing different functionality. Some 
browsers are text-based. They can only interpret text and, as a result, only display 
text. Images contained in Web sites cannot be viewed using text-based browsers. 
Other browsers can interpret text and images, but are based on early HTML 
standards and provide minimal functionality. Still other browsers make use of the 
latest advances in Web technology and incorporate functionality not supported by 
other browsers. These variations among browsers mean that any Web site or Web-
based application is interpreted and viewed many different ways across the 
Internet.

LEX has been designed for use with Microsoft Internet Explorer, employing 
functionality that’s unique to the browser and provides optimum LEX usability. 
Internet Explorer is the only LEX-supported browser. Although it might be 
possible to access LEX using other browsers, the best, most reliable results are 
achieved using Internet Explorer. 
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Communication errors
While accessing LEX, like other Web sites and Web-based applications, you may 
periodically receive communication errors from your browser. Browsers return 
communication errors (known as HTTP Status Codes) for many reasons. The 
most common errors occur when there are problems with how a page is requested 
or with how the server processes a page request. These errors are numbered 4xx or 
5xx, where xx is a number between 00 and 99. If you receive a browser 
communication error, log off LEX, close your browser, and log on to LEX again. 
If the problem persists, contact the IS Call Center. 

Checking for newer versions of stored pages
To ensure you always connect to the most up-to-date LEX software, you must set 
your Web browser to check for newer versions of pages that you previously 
viewed. In Internet Explorer, the option that controls this behavior is known as 
Check for Newer Versions of Stored Pages. To view or change the option:

1. Open Internet Explorer.

2. From the Tools menu, select Internet Options.

3. In Temporary Internet Files, click Settings.
Settings for the Check for Newer Versions of Stored Pages option control 
how frequently Internet Explorer checks for newer pages. LEX requires that the 
option is set to one of the following choices. Choose the setting that best suits 
your needs: 

 Every visit to the page: This setting causes Internet Explorer to check 
every time you view a page whether or not the page has changed since the last 
time you viewed it. If it has changed, Internet Explorer displays the new 
version of the page. 

 Automatically: Rather than check a page each time you visit it, this option 
tells Internet Explorer to check for and display a newer version of a page only 
when it is a page you viewed during a different work session or on a different 
day. Because the system checks pages less frequently, this option may provide 
faster response time.

For more information about this and other temporary Internet file settings, refer to 
your Internet Explorer online help. 
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Display settings
Web browsers let you customize the appearance of Web pages by changing 
display options such as the font and font size of text. While such changes might 
make a Web page easier for you to read, particularly if you have limited or low 
vision, they also cause the page to display differently than the Web author or 
designer intended. In some cases, the results may be undesirable. Similarly, 
browser customization can affect the display of your LEX browser windows.

LEX windows have been designed to accommodate Internet Explorer’s default 
text settings. At these settings, the windows will be optimally displayed. If your 
browser has been configured to display a different font or font size, you may 
notice that field labels are not properly aligned or that some fields are missing 
labels or parts of labels. If you experience difficulties such as these, your 
browser’s display settings have been changed. Restore the default display settings 
to correct the problem. For a list of topics relating to fonts and display settings, go 
to your Internet Explorer Help Index and type font. 

Configuring Internet Explorer Pop-up Blocker

Note:
This topic applies only to users of the Windows® XP operating system.

Pop-up Blocker is a security feature offered by Microsoft® Internet Explorer for 
the Windows® XP operating system. It helps protect your PC by blocking most 
pop-up windows. Since you may need to see the pop-up windows of certain Web 
sites, the feature allows you to name Web sites for which you want to allow pop-
ups. To successfully launch LEX, you must configure Pop-up Blocker to allow 
pop-ups from the AT&T Web Toolbar. AT&T recommends using the following 
steps. For more information about Internet Explorer Pop-up Blocker, see your 
Internet Explorer online help or visit www.microsoft.com.

1. Open Internet Explorer.

2. From the Tools menu, select Internet Options.
The Internet Options window opens with the General tab displayed.

3. Click the Privacy tab.

4. In the Pop-up Blocker section, verify whether or not Block Pop-ups is 
checked.
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If the option is not checked, Internet Explorer will permit AT&T Web Toolbar to 
send data to your PC. No further action is required. Please be aware, however, that 
other Web sites may also open pop-up windows that you do not want.

5. If Block Pop-ups is checked, click the Settings button.
The Pop-up Blocker Settings window opens.

6. In the box "Address of Web site to allow," type https://oss.att.com 
and then click Add. 
The AT&T Web Toolbar URL, https://oss.att.com, is added to the list of allowed 
sites.

7. Click Close to close the Pop-up Blocker Settings window.

8. In the Internet Options window, click Apply. Then, click OK to close the 
window.
Your new settings should now be in effect for the current and subsequent work 
sessions.
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LEX Online Help 

There are three levels of online help in LEX:

 Help topics: Provides instructions, definitions, and general LEX information.

 Field-level help: Describes all fields, both active and inactive (grayed out).

 Micro-level help: Displays the full name of a field in the LEX Desktop status 
bar with the field’s data characteristics and usage.

Each of these help levels is discussed over the following pages.

Help topics
To access the LEX help topics, you select Help Topics from the Help menu. The 
system then opens the LEX Online Help browser window. 
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At the top of the LEX Online Help window, you’ll find two sets of buttons. The 
panel buttons—Contents, Index, and Search—are used to explore the Help 
Topics. They control what is displayed in the yellow panel, on the left side of the 
browser window. When you click a button, it is highlighted in yellow to show it is 
the selected button. When you click a different button, the display changes. By 
again clicking the button that you first selected, you can return the yellow panel to 
its original display. 

The other three buttons, when clicked, perform actions depicted by the button 
icons. When you hold your cursor over each icon, the button name appears to help 
you remember the action it performs, as illustrated in the picture below. 

 The Back button returns you to the last topic you viewed. 

 The Print button sends the displayed topic to your printer. 

 The User Guide button opens an online copy of the LEX User Guide in 
Adobe’s Portable Document Format (PDF).

Contents, Index, and Search panel 
buttons. Click a button to change 
what’s displayed in the yellow panel.

Back
button

Print
button

User Guide
button
Pro
rep
of 
Res
© 2
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Contents panel

When you open the Help Topics option on the Help menu, the Contents panel is 
displayed. This panel contains general LEX information and step-by-step 
instructions that describe how to complete workflow tasks. Related topics are 
grouped together in folders and sub-folders. Click a folder to see what topics and 
sub-folders it contains. Topics are depicted as pages with turned-down corners. 
When you click a topic, it is presented in the adjacent panel, like the topic “LEX 
Overview” in the following illustration. 

In topics that provide task-based instructions, the instructions are presented as 
numbered steps. Keyboard keys and the names of LEX icons, fields, windows, 
folders, tabs, buttons, menus, and options appear in bold type. In the following 
example, the “Editing LSRs” folder contains six topics related to editing. The 
topic “Editing an LSR” has been clicked so that it is visible. Notice the numbered 
steps and bold type.

Click a page to access 
the help for that topic.

Open a folder by 
clicking the closed 
folder icon.
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Index panel

To search for specific subjects or topics of interest, click the Index button. The 
LEX Index displays a list of keywords related to LEX help topics. You can scroll 
through the list of keywords to make your selection, or you can type a word or 
phrase in the keyword box. As you type, the index scrolls to and selects the entry 
that most closely matches what you type. To view the topic, click the selected 
keyword. The topic will be displayed in the adjacent panel. At any time, you can 
click any keyword to view the related topic. 

Bold type 
depicts LEX 
buttons, 
menus, and 
menu 
options.

Steps are 
numbered.

Type a 
topic of 
interest or 
keyword 
here.

The index 
scrolls to 
and 
selects 
the 
closest 
match.
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Search panel

Click the Search button to display the LEX Search panel. This panel allows you 
to perform a complete search of the LEX help system using keywords, phrases, or 
field names. In the keyword box, type the word you want to find and press the 
Enter key on your keyboard. The help system begins searching all topics for the 
word. If the word is located, the Search panel lists all the topics in which the 
word was found. Click a topic to view it in the adjacent panel. If the word is not 
located, the Search panel displays the message, “No Topics Found.”

Field-level Help

Finding help for active fields

To access LEX field-level help for active fields (fields not grayed), place the 
cursor in the data field and press F1. LEX then displays a help topic that defines 
the field. It also lists data characteristics, valid entries for the field, one or more 
examples, and any notes that might be useful in entering data. Field-level help 
matches the LSOR fields and is modified with the LSOR updates. 

Finding help for inactive fields

LEX contains help for all fields, both active and inactive (grayed out), although 
help for inactive fields is not accessed using F1. To view help for an inactive field, 
open Help Topics on the Help menu and conduct a search for the field, as 
described in the following steps. You can also use these steps to find help for any 
active field or topic containing the keywords you provide.

Type a 
keyword 
or topic of 
interest 
here.

A list of 
topics 
displays 
here.
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1. From the Help menu, choose Help Topics. 
The LEX Online Help window opens with the Contents panel displayed.

2. Click the Search button to display the Search panel.

3. In the keyword box, type a field name or other keyword(s). If the field 
name or keyword consists of more than one word, type and between 
each word.
The Search panel lists all the help topics containing the field name or all the 
keywords you typed.

Note:
When you type “and” as part of a series of keywords, you tell the Help system to 
generate a list of topics in which each topic contains all the keywords. For exam-
ple, if you were to type “white and blue” only topics containing both the words 
“white” and “blue” would be displayed.

You may also choose to include “or” in your keywords. Using “or” tells Help to 
generate a list of topics in which each topic contains at least one of the keywords. 
Using the previous example, you might type “white or blue”. This example would 
display topics containing either the word “white” or the word “blue” or both.

Type a 
field 
name or 
key-
word(s) 
here.

A list of 
topics 
displays 
here.
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4. Click the topic that you want to view.
The selected topic is opened in the adjacent panel.

Click a 
located 
topic to 
display 
the topic 
in the 
adjacent 
panel.

The topic 
displays 
here.
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Micro-level Help
When you place your mouse pointer in a data field, micro-help displays in the 
status bar of your LEX Desktop window. This micro-help is an expansion of the 
acronyms you see as headings for the fields on the various forms. It also lists the 
data characteristics and usages of each field. For example, if the mouse pointer is 
in the PORTED NBR field on the NP Service form, you will see “Ported 
Telephone Number, 10 n, Required” displayed in the status bar. 

LSR Workspace

When you click in a field, LEX displays micro-help in 
the status bar of your LEX Desktop window.

Micro-help
(inset)
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Read Me file
Each time a new version of the LEX application is released, a Read Me file is 
issued as part of the release. This file contains a recap of the most significant 
changes included in the release. You’ll also find links to other useful information, 
including summaries of past releases, system requirements, and information about 
how to access and use the LEX online help and user guide.

To view the Read Me file, select View Read Me File from the Help menu. The 
file is then opened and displayed in a separate browser window, as depicted in the 
following example.You can scroll through the content or click the links to jump to 
particular areas of interest.
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Accessing LEX 

Toolbar on the Web
LEX is accessed through the AT&T Web Toolbar application after you have 
established an account with your Account Manager and requested user IDs for the 
application. You will then receive instructions to access Toolbar via a URL 
(Uniform Resource Locator) so that you can log on to access LEX. Talk with your 
Account Manager about access alternatives. 

If you encounter any problems during the logon procedure, contact the IS Call 
Center at 314-235-7225.

Launching LEX 

Warning:
Clicking the LEX icon while LEX is running causes the application to be 
restarted. This can result in the loss of unsaved LSR data. If LEX is running 
and you have an LSR selected, be sure to save before restarting LEX.

1. Log on to Toolbar.
For instructions, refer to your Toolbar documentation.

2. Click the LEX icon on the Toolbar.

The operating system launches your Web browser, opening a separate browser 
window. This window serves as the LEX Desktop. Like your main browser 
window, you can resize the LEX browser window so that you can switch between 

Access method URL

If you’re reaching the AT&T net-
work via one of the AT&T RAFs 
or via the internet:

https://osstoolbar.att.com
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LEX and other applications. The LEX window does not, however, provide the 
menus and other navigational tools that you might be accustomed to seeing in 
your Web browser. Instead, LEX provides menus and icons specific to LEX 
functionality. 

If, however, your user ID has been defined to allow access to more than one 
region, you are first prompted to select the region in which you would like to 
work. In this instance, the Select Region dialog, pictured in the following 
illustration, displays in the LEX browser window in place of the LEX Welcome.

LEX 
displays 
the 
current 
region 
here.
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3. If you are a multi-region user, select a region for this work session.
You can select a region in one of two ways. Click the button adjacent to a region 
name, or click a region on the map. As you move the cursor across the regions of 
the map, pop-up text displays the states that belong to each region.

4. Click Submit.
The LEX Welcome displays, showing the selected region in the LSR Header. 
When you’ve completed all work in the current region, you can switch to a 
different region without logging off and logging in to LEX again. Instead, use the 
Change Region option, located on the View menu, to change regions. For more 
information regarding changing regions, see Changing Regions of Operation in 
Chapter 5, Processing Local Service Requests.

Note:
Only one LEX browser session is allowed per user ID. If you attempt to log in to a 
workstation while logged in at a different workstation, the system will prompt you 
to choose whether or not to continue the session. If you continue, problems with 
editing and/or saving PONs may occur.    

As you move the 
cursor across 
the map, pop-up 
text, like this, 
displays the 
states in each 
region.
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LEX application time-out 

Warning:
Regularly save your work, as unsaved changes are lost if a LEX application 
time-out occurs. 

If you’ve had LEX open but inactive for an extended period of time, generally two 
hours, LEX ends your work session, automatically logging you out of the system. 
This is referred to as a time-out. If after receiving a time-out you attempt to work 
in the system, you will receive a message prompting you to log in again: “Your 
session has timed out. Click OK to close all LEX windows, then login to LEX 
again.” LEX also displays this message if you left a PON displayed in the LSR 
Workspace and LEX receives an update to the PON from another user or a 
downstream system. When you receive a time-out, you will not be able to process 
LEX transactions until you log in again. 

A work session may also terminate (or time out) if your network connection is 
lost. Possible causes are interruptions in your company’s internal network or a 
sudden change to your IP (Internet protocol) address, a number assigned to your 
PC for the purpose of locating it on the Internet. If you receive a time-out, exit the 
application and log in again to establish a new connection. If you are routinely 
logged out of LEX after a short duration, you may be experiencing a network 
connectivity issue. Contact your network administrator or the IS Call Center.    

Exiting LEX 
To exit LEX, you can select Exit from the File menu or click the Exit icon.

1. From the File menu, select Exit.
The LEX application prompts you with the Exit confirmation message.

2. Click OK to end the LEX session or click Cancel to continue working.
If you were editing an LSR and did not save your changes, the system will prompt 
you to save prior to closing. The LEX Desktop and all other browser windows, 
such as the Search Results window, are closed.

Warning:
Do not exit LEX using the Close (X) button in the upper corner of the LEX 
browser window. Although the LEX window will be closed, closing in this way 
can result in the loss of data, as browser constraints prevent LEX from checking 
for unsaved data prior to closing.     
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LEX Desktop    

The LEX Desktop opens as a window in your Internet browser software. At the 
top of the LEX browser window, you’ll find the title bar, which shows the name of 
the application. The window itself is partitioned into a number of areas. These 
areas are described below. Review the illustration on the next page to see where 
each one is located. 

Menus The pull-down menus File, View, Actions, Data 
Reports, and Help allow you to create and save docu-
ments, view and edit them, and perform various ordering 
and desktop activities. For more information about menu 
options, see the next section, Menus.

Icon Bar The icon bar provides shortcut buttons to most menu 
options. See the section Icon Bar in this chapter for more 
details.

LSR Header In the LSR Header, you’ll find general information about 
the selected LSR—its status, PON, version, user ID, last 
activity date and time, end user name, service type, and 
activity type. For more information about the Header 
content, see LSR Header later in this chapter.

LSR Tree The LSR Tree shows the various forms and sections that 
make up the selected LSR. You use the Tree to navigate 
these areas as you create and modify the LSR. For more 
information, see LSR Tree in this chapter.

LSR Tree 
Navigation 
buttons

Use these buttons to add, copy, delete, and navigate 
among forms and sections associated with line numbers 
(such as LNUMs, HNUMs, and DLNUMs). For more infor-
mation about line numbers, see Line number navigation 
in the LSR Tree section of this chapter.

LSR 
Workspace

The LSR Workspace displays the form or section you 
select in the LSR Tree. The Workspace is the primary 
work area where you enter LSR data. For details, see LSR 
Workspace in this chapter.
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Menus

At the top of the LEX Desktop are the pull-down menus File, View, Actions, 
Data Reports, and Help. These menus allow you to create and save LSRs, view 
them, generate reports, and perform various desktop functions. 

To view menu options, click a menu’s name. The menu opens, showing its 
contents. With this menu open, you can move your cursor left and right over the 
other menus to view their options without having to click them. The last menu you 
open remains open until you close it. To close a menu, click it a second time, or 
click anywhere else on the menu bar.

File menu options

New LSR
The New LSR option allows you to create new LSRs. See Chapter 5, Processing 
Local Service Requests, New LSRs for more information.

Save
The Save option allows you to save changes to the selected LSR or a new LSR. 
See Chapter 5, Processing Local Service Requests, Saving LSRs for more 
information.

The menu bar is 
located at the top of 
the LEX Desktop.
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Print Forms

LEX’s Print Forms option allows you to print one, several, or all of the forms of 
an LSR. See Chapter 5, Processing Local Service Requests, Printing your LSR 
forms for more information.

Bulk Ordering

The Bulk Ordering process allows for multiple LSRs to be created based upon a 
set combination of Service Type and Activity Type. This functionality is for the 
AT&T Southeast Region only.

Exit
You may close the LEX application by selecting the Exit option. See 
Chapter 3,Getting Started, Exiting LEX for more information.

View menu options

Search

This option provides you with the ability to use a specific set of criteria to initiate 
a search for matching LSRs throughout your company. See Chapter 5, Processing 
Local Service Requests, Using LEX’s Search Option for more information.

You can save the results of your search. See Chapter 5, Processing Local Service 
Requests, Saving your search results for more information.
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Inbox

Selecting this option allows you to view and work your own LSRs under your user 
ID. It acts as a shortcut to conducting a search in which your user ID is the search 
criterion. All LSRs currently assigned to your user ID with a Last Activity Date 
during the previous seven days will be included. See Chapter 5, Processing Local 
Service Requests, Inbox for more information.

View Errors

This option provides a list of errors associated with an LSR. It is available when 
the selected LSR or its previous version contains errors. Errors occur when you 
attempt to issue an LSR and LEX determines that required data is missing or after 
an LSR has been issued and a downstream system determines it contains errors. 
For more information about using View Errors to see a list of fields that must be 
completed, see Chapter 5, Processing Local Service Requests, Issuing LSRs. For 
information about using View Errors to process Fatal or Super Fatal errors 
returned by the OSSs, see Chapter 5, Processing Local Service Requests, 
Processing LSR Errors.

Refresh

Use this option to update the onscreen content of a selected LSR. Choosing 
Refresh tells LEX to retrieve any new information that’s been added to an LSR 
by other users or by OSSs since you opened it. This option is only available for 
LSRs not in edit mode. See Chapter 5, Processing Local Service Requests, 
Refreshing an LSR for more information.   

Change Region

Use the Change Region option to switch among AT&T regions of operation 
during a work session. The active region displays in the LSR Header of the LEX 
Desktop. For more information about regions and how to change which one is 
active, see Chapter 5, Processing Local Service Requests, Changing Regions of 
Operation.

Provider Notifications

This option generates a list of all provider notifications received. You can view 
the list onscreen or print it. Using this option, you can also delete from the list 
notifications that are no longer needed. See Chapter 5, Processing Local Service 
Proprietary - Not for use or disclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
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Requests, Managing Provider Notifications (AT&T 12-State Only) for more 
information.

Note:
Not applicable for the AT&T Southeast Region.

Actions menu options

The Actions menu contains all the options that allow you to make changes to 
existing LSRs. Only the options available for the selected LSR will be active.

Issue LSR
The Issue action allows you to issue an LSR. Issuing an LSR means you are 
releasing it for transmission to the OSSs to be processed and worked. See Chapter 
5, Processing Local Service Requests, Issuing LSRs for more information.

Copy LSR

The Copy LSR action allows you to create a copy of another LSR or an LSR 
template. This menu option is useful when you have LSRs for multiple customers 
who, with a few exceptions, have identical information. Also, you may take this 
action when an LSR was created under the wrong Activity Type. This allows you 
to copy an LSR and change the Activity Type without retyping the LSR. You can 
also choose to copy only the administrative details of an LSR. See Chapter 5, 
Processing Local Service Requests, Copying LSRs for more information.
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LSR templates are also created using the Copy LSR option. See Chapter 5, 
Processing Local Service Requests, Creating an LSR template for more 
information on templates.

Edit LSR

Use the Edit LSR action to update LSRs or template LSRs in your company. 
When you select Edit LSR, LEX locks the selected LSR so that other users cannot 
modify or delete the LSR while you’re working with it. While an LSR is in edit 
mode, you can type data, change existing data, and copy, cut, and paste data from 
field to field. See Chapter 5, Processing Local Service Requests, Editing LSRs for 
more information.

Close Edit

Use the Close Edit action to finish editing an LSR. By selecting Close Edit, you 
tell LEX to unlock the LSR so that you can perform other actions on it, such as 
print or issue. Closing edit mode also makes the LSR available to other users so 
that they too can make changes to it. See Chapter 5, Processing Local Service 
Requests, Closing edit mode for more information.

Supplement LSR

The supplement feature allows you to make changes to a previously issued LSR. 
The Supplement LSR action can only be performed on LSRs with the status of 
Issued, Processed, Jeopardy, and FOC. The supplement process copies the LSR, 
records the supplement type, and increments the version number by one. The LSR 
is then available for updating. See Chapter 5, Processing Local Service Requests 
(LSRs), Supplementing LSRs for more information.

When you select Supplement LSR, you’re presented with the following options:

 Other Changes: Allows you to modify any information on an LSR. See 
Chapter 5, Processing Local Service Requests, Modifying an issued LSR for 
more information.
Proprietary - Not for use or disclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
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 Change Due Date/APPTIME Data: Allows you to modify the following 
LSR fields: Desired Due Date (DDD), Desired Due Date Out (DDDO), 
Appointment Time DDD (APPTIMEDDD), Response Identifier (RESID), and 
Remarks. See Chapter 5, Processing Local Service Requests, Changing due 
date and appointment data for more information. (Fields may vary by AT&T 
Region.)

 Cancel LSR: Allows you to notify the OSS that work requested on an LSR 
that’s been issued is no longer required. Subsequent versions of the LSR 
remain unchanged. See Chapter 5, Processing Local Service Requests, 
Canceling an LSR for more information.

LSRs in LEX not awaiting response from downstream OSSs, such as those in 
Post to Bill status, can be deleted. Deleting an LSR completely removes it 
from the system, preventing users from accessing it. If you want to delete a 
PON, use Delete LSR under the Actions menu. See Chapter 5, Processing 
Local Service Requests, Deleting an LSR, for step-by-step instructions.

Clear Optional Forms

The Clear Optional Forms action allows you to clear all data from one or more 
optional forms. Which forms are optional is determined by the Service Type and 
Activity Type of the selected LSR. Clear Optional Forms is enabled on the 
Actions menu when you attempt to do one of the following actions:

 Edit a new LSR that has never been issued.

 Update an existing template LSR.

 Make changes to an LSR during a supplement (supplement type 3).

 Process errors.

See Chapter 5, Processing Local Service Requests, Clearing Optional Forms for 
more information.

Delete LSR

LSRs in LEX not awaiting notification or confirmation from AT&T OSSs, such as 
those in Post to Bill status, can be deleted. Deletion removes it from the system so 
that it cannot be retrieved by users. If you want to delete an LSR, use the Delete 
LSR option under the Actions menu. See Chapter 5, Processing Local Service 
Requests, Deleting LSRs for more information.
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LSRs awaiting response from AT&T OSSs, such as those in Issued status, can be 
canceled. Canceling an LSR notifies AT&T OSSs to cancel all provisioning. If 
you want to cancel a PON, use the Supplement LSR option on the Actions 
menu. Supplement LSR provides a secondary option to Cancel. See Chapter 5, 
Processing Local Service Requests, Canceling an LSR for more information.

Process Errors

The Process Errors action lets you correct LSR errors in LEX. LEX displays 
two types of error statuses: Fatal Error and Super Fatal. These error statuses on an 
LSR represent LSRs that have been returned to LEX from AT&T OSSs. For each 
error, an OSS provides LEX with the error code and a message that explains the 
error. LEX displays this information in the View Errors window. When it’s 
received from the OSS, LEX will also provide the line number on which the error 
resides, the LEX field name, and the LEX form where the field is located. 

Super Fatal errors are errors resulting from invalid data or the absence of key data 
that prevents further processing of the request. For instructions for processing 
errors for both error status codes (Fatal Error or Super Fatal), see See Chapter 5, 
Processing Local Service Requests, Processing LSR Errors.

Cancel

The Cancel action is only available when LEX is displaying a dialog in the LSR 
Workspace. Like the Cancel button in any dialog, it allows you to discontinue a 
selected action and return to the previous data-entry area. For example, when you 
create a new LSR, LEX opens the Create LSR dialog so you can type a PON and 
select a service type. If you decided not to continue creating the LSR, you would 
click the Cancel button in the dialog. Or, you could instead select Cancel from 
the Actions menu. 

Periodically, you will receive errors from your Internet browser due to 
communication problems. Cancel is especially helpful when this occurs. When a 
browser error is received, it will be displayed in the LSR Workspace so that you 
cannot continue. To continue working, select Cancel. The error will be cleared, 
returning the LSR Workspace to its previous state.
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CLEC Profile Utility

This function allows data associated with a company code to be updated by the 
user and used in the Create LSR process for pre-population of fields.

Note:
Browsers return communication errors (known as HTTP Status Codes) for many 
reasons. The most common errors occur when there are problems with how a page 
is requested or with how the server processes a page request. These errors are 
numbered 4xx or 5xx, where xx is a number between 00 and 99. If you receive a 
browser communication error, log off LEX, close your browser, and log on to LEX 
again. If the problem persists, contact the IS Call Center. 

Data Reports menu options

The Data Reports menu is used to generate reports from LEX. When you open 
the menu, you are presented with a list of report categories. Each category is a 
sub-menu that contains related data reports. Place your cursor on a sub-menu to 
see the reports that are available. A complete list of reports is provided in Chapter 
7, Data Reports, How the reports are organized. Detailed descriptions of reports 
as well as instructions to generate the reports are also included in Chapter 7.
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LSR/Service Form Data

The LSR/Service Form Data sub-menu lists reports that provide data from the 
LSR and End User forms as well as various service forms, such as Loop or Port.

Current Notifications

The Current Notifications sub-menu lists reports that provide data from 
notification forms, namely, the FOC, SOC, Error, Jeopardy, and Post to Bill 
notifications.

Coordination

The Coordination sub-menu lists reports that provide data associated with 
transactions that may require coordination between your company and AT&T.

Historical Analysis

The Historical Analysis sub-menu lists reports that provide information that can 
be used to analyze and compare LSR and company data.

Usage Analysis

The Usage Analysis sub-menu lists reports that provide data summarizing the 
activities of LEX users.

Help menu options

LEX Tips
The LEX Tips option provides helpful hints and other information useful to 
operating the LEX application. See Chapter 5, Processing Local Service 
Requests, Viewing LEX Tips for additional information. 
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Help Topics

The Help Topics option opens the LEX Online Help browser window where 
you’ll find two sets of buttons. The panel buttons—Contents, Index, and 
Search—are used to explore the Help Topics. The other three buttons, when 
clicked, perform actions depicted by the button icons. When you hold your cursor 
over each icon, the button name appears to help you remember the action it 
performs. See Chapter 2, Introduction, LEX Online Help for additional 
information about LEX’s online help.

View Read Me File
The View Read Me File option provides all the details on application 
enhancements and corrections to the version of LEX you are currently running. 

About

The About option provides the phone number and hours for the IS Call Center 
and the Mechanized Customer Production Support Center.    
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Icon Bar

Just below the pull-down menus at the top of the LEX Desktop is the Icon bar. 
The LEX Icon bar, pictured above, is made up of buttons that are shortcuts to 
menu options. Throughout this user’s guide, procedures are described using the 
menu options, although you can use the buttons if you prefer. 

To help you remember how each button is used, a tooltip appears 
when you move your cursor over it. The tooltip shows the name of the 
button’s menu option. Notice, too, the placement of the buttons. They 
are grouped by the menus on which their options are located, as 
indicated in the illustration. Together, these visual cues tell you 

exactly which option on which menu you’re choosing when you click a button.

For more information about how to use each option, see Chapter 3, Getting 
Started, Menus. In this section, the menu options are listed and their functionality 
described. You’ll find them listed in the order they appear on the menus.

File buttons View buttons Action buttons Help

Inbox

Supplement

Clear Optional 
Forms

Process 
Errors

Change 
Region

Copy

Close 
Edit

ExitSave

New Print Issue Edit Help

RefreshSearch

Delete

LEX Tips

Bulk 
Ordering
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LSR Header

At the top of your desktop window, below the menu bar, is the LEX LSR Header. 
The LSR Header provides details about the LSR you’ve selected.

All columns in the LSR Header are sizable. When you move your mouse pointer 
close to the edge of a column heading, it changes to a two-headed arrow and you 
can resize the column. This change is not permanent, however. The next time you 
logoff and re-enter LEX, all columns return to their original proportions.

Status field

The Status field in the LSR Header identifies the current status of an LSR. As an 
LSR moves through the LEX order process, its status automatically changes. LEX 
sends the LSRs you’ve issued to the AT&T OSSs. If the LSR passes edits, you 
will receive a status of Processed. If not, you will receive a status of Fatal Error or 
Super Fatal, at which time you can choose to process your errors and resubmit the 
LSR. 

Each time you select a PON, the status for that PON in the LSR Header changes to 
the current status. A list of LSR statuses follows. 

Status Description
New An LSR that has not been issued to the OSSs for order pro-

cessing.
Template A read-only, reusable copy of an existing LSR created by 

using the Actions menu, Copy option.
Supplement LSR for which a supplement has been created. Supplements 

include LSR cancellations as well as modifications to an LSR 
due date, appointment data, or other information.

When you move the pointer to a column’s edge, 
it becomes a two-headed arrow, indicating that 
the column can be resized.
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PON field

The PON field in the LSR Header identifies the CLEC’s unique purchase order or 
requisition number that authorizes the issuance of this request or supplement. 

Pending An LSR for which the Issue action has been executed in LEX, 
but which has not yet been successfully transmitted to nor 
picked up by the downstream OSSs. 

Issued LSR that has been picked up for processing by the OSS.         
Processed An LSR that has been returned to LEX from the OSSs, has 

passed initial edits, and is awaiting confirmation of the due 
date.
Note: Requests in Processed status may be manually 
rejected by the Local Service Center (LSC). Also, they may 
yet receive initial edits as a result of downstream system 
failures.

Fatal Error 
and
Super Fatal

Errors AT&T downstream systems have returned for correc-
tion. The OSS provides LEX with an error code and error 
message for each error. When possible, it provides the line 
number, field name, and location. Super Fatal errors are 
errors resulting from invalid data or the absence of key data 
that prevents further processing of the request.

Worked Version of LSR for which errors have been processed.
FOC Confirmation of the LSR’s requested due date by the OSSs. 

A FOC may be contingent upon LSC activity, which is 
recorded as Provider Initiated Activity. See LSR Workspace, 
Notifications, FOC notification in Appendix E, LEX Forms for 
more information.

Complete Confirmation that the work associated with the LSR has 
been completed by AT&T. Also known as a Service Order 
Completion (SOC).

Post to Bill* Notification provided to the CLEC when all service orders for 
an LSR have been posted to the billing system. Post to Bill is 
the final status for LSRs, excluding Requisition Type J LSRs 
or LSRs with Activity Type R.

Cancel FOC Cancel confirmation on a canceled LSR.
AT&TCancel Notification provided to the CLEC that AT&T has canceled an 

LSR because the CLEC did not respond to a previous jeop-
ardy notification within the required time frame. 

Jeopardy Notification that is returned when an order is in jeopardy as 
a result of facility problems and/or other type of problems.

*  This is for the AT&T 12-State Regions. For the AT&T Southeast Region, 
the equivalent status is Billing Completion Notice.
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PONs cannot be reused if they’ve been issued to the OSSs. If you use a PON and 
delete it before issuing it, you may reuse the PON.

VER field

The VER field in the LSR Header identifies the version of the request or 
supplement for the selected LSR. All LSR re-issuance version numbers are 
sequentially numbered by LEX to uniquely identify each LSR version. LEX 
allows up to 99 versions of an LSR. If you need to continue processing the LSR 
beyond version 99, you will need to use the Copy LSR action to create a full copy 
of the LSR.

User ID field

The User ID field in the LSR Header identifies the person who last updated 
information for the LSR.

Last Activity D/T field

The Last Activity D/T field the LSR Header shows the creation date or the last 
modification date of the LSR.

End User Name field

The End User Name field in the LSR Header identifies the CLEC’s customer 
name. This field displays the information entered in the Name field on the LSR 
form, End User Location section.

Service Type field

The Service Type field identifies the type of service requested for the LSR. Each 
Service Type is preceded by the one-character Requisition Type value. The 
service types available are:

 2- ISDN PRI Port

 3- Digital Trunking Port *

 A- Loop

 B- Loop Service with Number Portability

 C- Number Portability

 E- Resale Service
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 F- Unbundled Local Switching (Port)

 J-  Directory Service Request

 K- Resale Private Line

 M-Port with Loop

 P- Centrex Resale Service

 R- Digital Trunking Resale

 S- Digital Trunking Port with Loop

 T- DID/PBX Resale

 U- DID/PBX Port

 V- Centrex Port *

 W- DID/PBX Port with Loop

 X- Centrex Port with Loop

 Y- ISDN PRI Port with Loop

 Z- ISDN PRI Resale

*  Not applicable for the AT&T Southeast Region.

Activity Type field

The Activity Type field identifies the type of activity requested for the LSR. The 
types of activity available are:

 B - Restore Service

 C - Change

 D - Disconnect

 L - Suspend Full Account (AT&T Southeast Region)

 N - New Install

 R - Record Change

 S - Suspend Service

 T - Outside Move

 V - Conversion with Change

 W- Conversion As Is 

 Y - Deny/Short Term Suspension
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LSR Tree

The LSR Tree, pictured to the left, is a 
navigation tool that works like Windows 
Explorer. It is used to view the many 
forms and sections that make up an LSR. 
Forms and sections are generally 
comprised of other subordinate 
components—line numbers, tabs, and 
detail lines—that altogether make up a 
complete request. Each level of an LSR 
is, therefore, hierarchically subordinate to 
the level that precedes it, much like the 
branches of a tree, as illustrated on the 
following page.

The forms and sections you see in the LSR Tree vary by LSR. When an LSR is 
selected, LEX checks the type of service and activity for that LSR. Based on 
these, it builds the contents of the LSR Tree starting with the PON at the top. 
Following the PON, the version number of the LSR appears in parentheses. In the 
example of the Tree pictured above, the displayed PON is version 2, as indicated 
by (02). 

Forms are at the highest level in the LSR Tree. In the example on this page, LSR, 
End User, Loop with NP, and DL are all forms. Some forms, such as LSR and End 
User, are made up of multiple sections. The sections are grouped together in a 
folder, just as a collection of papers and documents is grouped together in a paper 
file folder. Other forms, such as Loop with NP, do not include sections and, thus, 
reside at the highest level without a folder.

Preceding a form folder you’ll find a plus or minus sign. The plus sign (+) 
indicates that there’s more to see, and thus, that the folder is closed. To see what 
sections the folder contains, click the plus sign. Conversely, a minus sign (-) 
indicates the folder is open. Click the minus sign to close the folder.

Form 
without 
sections

Folder

Section

Click the plus sign 
to open a folder.

Click the minus 
sign to close a 
folder.
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LSR

A form may have one 
or more sections.

A section may have o
or more occurrences, e
called a “line number.”

A line number m
be divided into on
or more tabs. 

Detail lines provide 
the greatest level of 
detail.

One or more detail lines 
can be added to a tab.

An LSR is comprised of many subordinate components, like a
tree is comprised of many increasingly smaller branches. The
first level, or branch, of the LSR tree is the form. In its simplest
state, a form is comprised of a number of data-entry fields. 

Here, the most complicated tree structure is depicted: A form 
that contains two or more sections, each section having multiple 
occurrences (line numbers). Each line number in the section has 
several tabs for entering data. In a tab, one or more detail lines 
provide the greatest level of detail on the form.
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Forms, sections, and tabs
All data entry is done in the LSR Workspace using forms, sections, and tabs. 
These data-entry areas provide fields that you use to make selections and type 
information. You can see what fields a form or section contains by clicking it in 
the LSR Tree. When you click a form or section in this manner, it is displayed in 
the LSR Workspace so you can enter the necessary information.

In the LSR Workspace, some forms and sections are subdivided into tabs. A tab is 
a collection of related fields that belong to a form or section. Tabs group together 
related fields, enabling you to find information more easily and to more efficiently 
create LSRs. To view the contents of a tab or enter information in a tab, simply 
click the tab in the LSR Workspace. The tab and the fields it contains are 
displayed in the foreground, sending the previously displayed tab to the back. 

As an example, in the LSR Tree you can click the Admin section in the LSR 
folder to open the Administration section of the LSR form in the LSR 
Workspace. This section, pictured below, contains three tabs: Admin, RPON, and 
Account Features.      

Click Admin to 
open the section 
in the LSR 
Workspace.

The Admin 
section contains 
three tabs.
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Line number navigation 
Just below the LSR Tree, you’ll find a series of buttons. These buttons are used to 
add, copy, and delete multiple occurrences of a form or section. Each occurrence 
is referred to as a line number. The First, Next, Prev, Last, and Go buttons let 
you navigate the line numbers of forms and sections of an LSR and navigate 
multiple FOC notifications, too. 

To demonstrate how these buttons are used, the HGI (Hunting Group 
Information) form will be used as an example. The concepts discussed here for 
HGI line numbers (HNUMs) apply to all other forms and sections having line 
numbers, such as LNUM, TGLNUM, TNNUM, CNUM, DIDNUM, FNUM, 
LEGNUM, and so forth. 

Like other LSR forms and sections, the HGI form allows you to add one or more 
line numbers. In the case of HGI, this means you can add one or more hunt groups 
(HNUMs) to a single LSR. You can find out how many line numbers already exist 
in a form or section by looking at the number (in parentheses) that follows it. Until 
a line number is added, this number remains set to (0). 

To begin working with a form, such as HGI, you click the form in the LSR Tree. It 
then opens in the LSR Workspace so that you can begin entering data for the line 
numbers. The number in the LSR Tree is incremented to (1), indicating the new 
line number quantity. 

Quantity is displayed in the LSR Workspace, where you’ll also find the current 
line number. You’ll find these numbers in the line number indicator in the upper 
right-hand corner of the Workspace. 

Line number 
navigation buttons
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Click Add to add an HNUM 
(hunt group) to the LSR.

Enter the hunt group information 
in the LSR Workspace.

Upon clicking HGI, the quantity is 
incremented from 0 to 1.

The line number indicator shows the current 
NUM and the total NUM quantity (QTY).
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LEGNUMs

Line number quantities are displayed somewhat differently for Resale Private 
Line requests, as Resale Private Line is the only service form that includes two 
levels of line numbers. The top level on the Tree, represented by the form folder, 
uses LNUMs as line numbers. The second level, consisting of the Primary and 
Secondary Location sections, uses LEGNUMs as line numbers. Each LNUM 
can have multiple LEGNUMs associated with it—one primary LEGNUM and 
multiple secondary LEGNUMs. Because LNUMs are the higher level of line 
numbers, the LNUM quantity is displayed in the LSR Tree, next to the Resale 
Private Line folder, as well as in the LSR Workspace. LEGNUM quantities, on 
the other hand, are only displayed in the LSR Workspace for the Primary Location 
or Secondary Location.

To view the LEGNUMs of the Primary or Secondary Location, you must first 
select the LNUM with which it’s associated. Click the Resale Private Line 
folder and use the navigation buttons to locate the LNUM you need. Once the 
correct LNUM is displayed, click Primary Location or Secondary Location in 
the LSR Tree to open the section in the Workspace. There, you’ll find LNUM and 
LEGNUM indicators. At this point, using the navigation buttons applies to the 
LEGNUMs. Use the navigation buttons to locate the correct LEGNUM. 
Illustrations of the Resale Private Line sections and their line number indicators 
are provided in Appendix E, LEX Forms, Resale Private Line form.

Adding a line number

As you add line numbers (also known as NUMs) to forms or sections of an LSR, 
LEX sequentially numbers them. NUM names differ by section or form. In the 
case of HGI, each NUM is an HNUM. 

1. If you’re adding to an existing LSR, place the LSR in edit mode. 
Otherwise, if you’re creating a new LSR, the LSR is already in edit 
mode; go to Step 2.
See Editing an LSR in Chapter 5, Processing Local Service Requests.

2. In the LSR Tree, click the form or section to which you need to add a 
line number.
LEX responds by opening the form in the LSR Workspace. If the fields of the 
form do not contain data, you can begin entering the appropriate information to 
create the first line number. 

3. If the opened form contains data, click Add in the Navigation panel of 
the LSR Tree to add a new line number.
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The new form then opens in the LSR 
Workspace. LEX updates the quantity in 
the LSR Tree, updates the quantity (QTY) 
in the LSR Workspace, and increments the 
line number, assigning it the next 
sequential number.

Note:
Add buttons in the LSR Workspace add detail lines to a line number. They do not 
add line numbers to a form or section of a form. For example, the Add button in 
the LSR Workspace for HGI adds telephone or terminal numbers to the sequence 
of a hunt group. To add a detail line to a line number, click the Add button in the 
LSR Workspace. Detailed instructions are available in “Adding a detail line” on 
page 3.32.

4. Begin entering the line item information.

5. If you need to add a detail line, click Add in the LSR Workspace, which 
is active if the line number is one that uses detail-level line numbers.
For example, if you need to add a telephone number to the sequence of a hunt 
group, click Add in the LSR Workspace when the HGI form is displayed. 

6. If you need to delete a detail line, click Delete in the LSR Workspace.

Copying a line number

What if you want to add a new line number with the same information as an 
existing NUM? You use the Copy button to add a new line number that has the 
same information as one that already exists. 

1. If you’re working with an existing LSR, place the LSR in edit mode. 
Otherwise, if you’re creating a new LSR, the LSR is already in edit 
mode; go to Step 2.
See Editing an LSR in Chapter 5, Processing Local Service Requests.

2. In the LSR Tree, click the form or section to which you need to add 
another line number.

3. Display the line number you want to copy using the navigation buttons: 
First, Next, Prev, Last, and Go.
For information about how to use these buttons, see Viewing line numbers.

Click Add in the LSR Tree 
to add line numbers.
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4. Click Copy in the Navigation panel of the LSR Tree.
A new line number with the same information is then created and assigned the 
next available number. For example, if you were to copy HNUM 3, the new line 
number would be HNUM 4. It would have the same information as HNUM 3, 
until you make changes.

Deleting a line number

What if you realize that a line number is an incorrect duplicate or needs to be 
removed from the LSR for some other reason? LEX allows you to delete line 
numbers, completely removing them from the system. When you delete a line 
number, its data is removed from the system. All of the subsequent line numbers 
are renumbered so that the next item in the sequence takes the place of the deleted 
one. For example, if you had a total of four HNUMs and deleted HNUM 2, 
HNUM 3 would become HNUM 2 while HNUM 4 would become HNUM 3. If 
another HNUM were then added to the LSR, it would fill the next available 
number, HNUM 4. 

1. If you’re working with an existing LSR, place the LSR in edit mode. 
Otherwise, if you’re creating a new LSR, the LSR is already in edit 
mode; go to Step 2.
See Editing an LSR in Chapter 5, Processing Local Service Requests.

2. In the LSR Tree, click the form or section from which you need to 
delete a line number.

3. Display the line number you want to delete using the navigation 
buttons: First, Next, Prev, Last, and Go.
For information about how to use these buttons, see the next section, Viewing line 
numbers.

4. Click Delete in the Navigation panel of the LSR Tree.

Click Add in the LSR Tree 
to add line numbers.

Click Copy to add a line number 
with duplicate data.
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The line number is completely removed from LEX. Any subsequent line items are 
renumbered so that the next item in the sequence takes the place of the deleted 
one. For example, if you were to delete number 2, number 3 becomes number 2. 

Note:
Delete buttons in the LSR Workspace remove detail lines from a line number. 
They do not delete line numbers from a form or section of a form. For example, 
the Delete button in the LSR Workspace for HGI deletes telephone numbers from 
the sequence of a hunt group. Detailed instructions are available in “Deleting 
detail lines” on page 3.33.

Viewing line numbers 

How do you view a particular line number? The line numbers of forms and 
sections in LEX are sequentially ordered. Much like the pages of a book, you can 
page through the line numbers one after another, forward and backward, until you 
find the one you want. If, however, you know the assigned number of the line 
number you need, you can go directly to it by typing the number and clicking Go.

If you need to view a LEGNUM of a Resale Private Line request, you will 
perform these steps at the LNUM level and then at the LEGNUM level. Begin by 
clicking the Resale Private Line form in the LSR Tree and locate the correct 
LNUM. Once you’re viewing the correct LNUM, click the Primary or 
Secondary section. If you choose Primary, you will be viewing LEGNUM 1. If 
you choose Secondary, you will be viewing LEGNUM 2. To view a different 
secondary LEGNUM, repeat the steps to locate the correct LEGNUM.

1. In the LSR Tree, click the form or section that contains the items you 
want to view.
The form or section opens in the LSR Workspace, and you’re positioned at the 
first line number. To see which line number you are viewing, check the line 
number indicator in the upper, right-hand corner of the Workspace. 

In the LSR Tree, click Add 
to add line numbers.

Click Delete in the LSR Tree to remove a line 
number, renumbering all subsequent line items.

Click Copy to add a line number with 
duplicate data.
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2. If you know the assigned number of the line number you want to view, 
type the number in the Go box and click the Go button.
The assigned number is the NUM that displays in the line number indicator in the 
upper, right-hand corner of the LSR Workspace. 

3. Use the First, Next, Prev, and Last buttons to page through the items.
 To go forward, click Next or Last. Next advances you to the next line 

number as if you were turning the page of a book. Last takes you to the very 
last line number, like going directly to the last page of a book.

 To go backward, click First or Prev. First takes you to the very first line 
number. Prev takes you to the line number that precedes the one you’re 
viewing. 

        

The line number indicator is in the upper, right 
corner of the LSR Workspace. It shows the 
current NUM and the total NUM quantity (QTY).

To go to LNUM 2 from any other line number, 
you would type 2 in the Go box and click Go.

Click Last to view the last 
line number.

Click First to view the first 
line number.

Click Previous to view the 
line number that precedes the 
current line number.

Click Next to view the line 
number that follows the 
current line number.
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Adding a detail line

When you’re adding a line number to a form or section or viewing a line number 
in edit mode, you can add detail lines to the line number. Detail lines provide 
additional information about a line number. For example, in the HGI form, each 
line number is a hunt group. Each hunt group is comprised of a sequence of 
telephone numbers. The telephone numbers are detailed information that 
completes the hunt group definition. Phone numbers are added to a hunt group as 
detail lines of the hunt group line number.

1. If you’re adding to an existing LSR, place the LSR in edit mode. 
Otherwise, if you’re creating a new LSR, the LSR is already in edit 
mode; go to Step 2.
See Editing an LSR in Chapter 5, Processing Local Service Requests.

2. Display the line number to which you need to add a detail line.
Navigate to the line number by selecting the form or section and tab, if applicable, 
to which it belongs. Then, use the buttons in the navigation panel of the LSR Tree 
to display the correct line number. For more information about viewing a line 
number, see Viewing line numbers.

3. Click the Add button in the LSR Workspace.
Add is available only if the line number is one that requires detail lines and the 
maximum number of detail lines hasn’t been reached. Many line numbers allow 
up to 99 detail lines. If a line number already contained 99 detail lines and you 
were to attempt to add another, the Add button would be dimmed (grayed out).
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4. Begin typing the required data to complete the detail line.

Deleting detail lines

1. If you’re modifying an existing LSR, place the LSR in edit mode. 
Otherwise, if you’re creating a new LSR, the LSR is already in edit 
mode; go to Step 2.
See Editing an LSR in Chapter 5, Processing Local Service Requests.

2. Display the line number from which you need to delete one or more 
detail lines.
Navigate to the line number by selecting the form or section and tab, if applicable, 
to which it belongs.Then, use the buttons in the navigation panel of the LSR Tree 
to display the correct line number. For more information about viewing a line 
number, see Viewing line numbers.

3. Locate the detail line(s) you want to delete in the list in the LSR 
Workspace.
If the line number contains many detail lines, you may need to scroll down the 
page to locate the ones you want.

Click the Add button in the LSR Workspace 
to add a detail line to a line number.

When you click Add, a new detail line is 
added to the bottom of the list in the LSR 
Workspace.
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4. In the Delete column, click the checkbox next to each detail line to be 
deleted.

5. Click the Delete button in the LSR Workspace.
All detail lines you checked are removed from the list.

   

Click the Delete button in the LSR 
Workspace to remove selected detail lines.

Click the checkbox next to line items you 
want to remove to select them for deletion.
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LSR Workspace

The main work area of the LEX application is the LSR Workspace. You use the 
Workspace to enter and view LSR information and to make changes to 
information using LSR forms. To display a form in the Workspace, you click the 
form in the LSR Tree, as described in the previous section. While an LSR is made 
up of multiple forms, some forms, in turn, are made up of multiple sections, which 
are secondary input areas.

Throughout this guide, you’ll find illustrations of LEX data-entry areas. These 
illustrations are intended to help you learn how to use the LEX user interface and 
to demonstrate how to perform LEX procedures. For information regarding the 
use and availability of the illustrated forms and the fields they contain, consult the 
most current AT&T LSOR for business requirements.

LEX contains the following forms. Sections that make up a form are listed with 
their corresponding forms. Where applicable, tabs are also listed with the service 
forms and/or sections with which the tabs are typically affiliated.  

Form Section Tabs in the form or section
LSR Admin Admin, RPON, {Account Features 

(AT&T 12-State Regions only)}
Bill Bill
Contact Contact

HGI No sections Hunting Group Information
End User Location Location

Disconnect Disconnect

LEX Forms, Sections, and Tabs
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Loop No sections Loop, Transfer of Calls, {IW Jacks 
(AT&T Southeast Region only)}

Loop with NP Loop with NP, {Transfer of Calls 
(AT&T 12-State Regions only)}, 
{IW Jacks (AT&T Southeast Region 
only)}

NP NP
Port Port, Transfer of Calls, Features, 

{IW Jacks (AT&T Southeast Region 
only)}

Port with Loop Port with Loop, Transfer of Calls, 
Features, {IW Jacks (AT&T South-
east Region only)}

Resale Resale, Transfer of Calls, Features, 
IW Jacks

Centrex Resale Common Block Common Block
Centrex Details Centrex Details, Location, Transfer 

of Calls, Features, IW Jacks
Centrex Port
(REQTYP V is for 
AT&T 12-State 
Regions only)

Common Block Common Block
Centrex Details Centrex Details, Location, Transfer 

of Calls, Features

Centrex Port with 
Loop

Common Block Common Block
Centrex Details Centrex Details, {Location (AT&T 

12-State Regions only)}, Transfer 
of Calls, Features

DID/PBX Resale Trunk Details Trunk Details, Transfer of Calls, 
Features, IW Jacks

DID Trunk 
Groups

DID TG Details, {NBANKS (AT&T 
12-State Regions only)}, {DTNS 
(AT&T 12-State Regions only)}, 
Transfer of Calls

DID/PBX Port Trunk Details Trunk Details, Transfer of Calls, 
Features

DID Trunk 
Groups

DID TG Details, {NBANKS (AT&T 
12-State Regions only)}, {DTNS 
(AT&T 12-State Regions only)}, 
Transfer of Calls

Form Section Tabs in the form or section

LEX Forms, Sections, and Tabs
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DID/PBX Port 
with Loop 

Trunk Details Trunk Details, Transfer of Calls, 
Features

DID Trunk 
Groups

DID TG Details, {NBANKS (AT&T 
12-State Regions only)}, {DTNS 
(AT&T 12-State Regions only)}, 
Transfer of Calls

Digital Trunking 
Resale

DS1 Circuit Details, Location, Features
Trunk Groups TG Details, Features
DID TNS DID TNS Details, {NBANKS (AT&T 

12-State Regions only)}, {DTNS 
(AT&T 12-State Regions only)}, 
Transfer of Calls

Trunks Trunk Details, Transfer of Calls, 
Features, Line Side Details, {IW 
Jacks (AT&T Southeast Region 
only)}

Digital Trunking 
Port
(REQTYP 3 is for 
AT&T 12-State 
Regions only)

DS1 Circuit Details, Location, Features
Trunk Groups TG Details, Features
DID TNS DID TNS Details, NBANKS, DTNS, 

Transfer of Calls
Trunks Trunk Details, Transfer of Calls, 

Features, Line Side Details
Digital Trunking 
Port with Loop

DS1 Circuit Details, Location, Features
Trunk Groups TG Details, Features
DID TNS DID TNS Details, NBANKS, DTNS, 

Transfer of Calls
Trunks Trunk Details, Transfer of Calls, 

Features, Line Side Details, {IW 
Jacks (AT&T Southeast Region 
only)}

ISDN PRI Resale DS1 Circuit Details, Location, Features
Trunk Groups TG Details, Features
B&D Channels Channel Details, Features
PRI TNS PRI TNS Details, NBANKS, DTNS, 

Transfer of Calls

Form Section Tabs in the form or section

LEX Forms, Sections, and Tabs
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LSR forms are described in Appendix D, LEX NPA Split Conversions. 
Descriptions and illustrations of each form are provided.

ISDN PRI Port DS1 Circuit Details, Location, Features
Trunk Groups TG Details, Features
B&D Channels Channel Details, Features
PRI TNS PRI TNS Details, {NBANKS (AT&T 

12-State Regions only)}, {DTNS 
(AT&T 12-State Regions only)}, 
Transfer of Calls

ISDN PRI Port 
with Loop

DS1 Circuit Details, Location, Features
Trunk Groups TG Details, Features
B&D Channels Channel Details, Features
PRI TNS PRI TNS Details, {NBANKS (AT&T 

12-State Regions only)}, {DTNS 
(AT&T 12-State Regions only)}, 
Transfer of Calls

Resale Private 
Line

Resale Private 
Line

Circuit Details

Primary Location Location, Features, IW Jacks, 
{Add’l Data (AT&T Southeast 
Region only)}

Secondary Loca-
tion section

Location, Features, IW Jacks, 
{Add’l Data (AT&T Southeast 
Region only)}

Directory Listings Directory Listings Listing Control, Listing Indicators, 
Listing Instructions, SLU Indent

Delivery Delivery
Advertising Advertising 

Form Section Tabs in the form or section

LEX Forms, Sections, and Tabs
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In each form, LEX requires a minimum of fields to be input before the LSR can be 
issued. Fields that require input are indicated by green labels. All other fields fall 
into one of the following categories (as defined by your LSOR), depending on 
Service Type and Activity: required, optional, conditional, or prohibited. 

Refer to your LSOR for details about the required field values and conditional 
usage. It contains Condition notes and Data Entry Conditions for fields. 
Microhelp for each active field displays in the LEX status bar at the bottom left of 
the application window. More detailed field-level help for all fields, whether 
active or inactive, exists for every LEX field. See Chapter 2, Introduction, 
Accessing Online Help for information on how to access LEX’s field-level help. 
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This chapter provides
information relevant to the

Pre-Order functionality available
in LEX.
CHAPTER





Pre-Order Integration
Overview 4
Overview

Pre-order Integration is the functionality that during the process of creating an 
LSR, LEX and Verigate will perform interactive activities that will allow for 
certain Pre-order information to be returned to LEX. This process begins initially 
at the Create LSR screen, that once certain data is entered on that screen, which is 
region specific, will allow the user to proceed forward and utilize certain Verigate 
inquiries while within LEX. These Pre-order inquiries are launched from links on 
specific LSR forms. This integration is limited to the basic core products of 
Requisition Types A, B, C, E, F, M, and J.

Pre-order functionality within LEX will consist of the following:

 Address Validation - Link contained on the LSR End User (EU) Form.

 TN Reservation - Link contained on the Product Form.

 Feature Inquiry - Link contained on the Product Form/Feature Section.

 PIC/LPIC - Link contained on the Product Form.

 Customer Service Inquiry - Link contained on the LSR End User (EU) Form.

 Due Date Calculation - Link contained on the LSR Admin Form (regional 
specific.

Pre-order Integration within the firm order process is optional to the user; 
should the links described above not be selected by the user, the user can manually 
enter all the necessary information. However, if an address is not validated via the 
address validation link, other Pre-order links dependent upon a validated address 
will or may not work.

Note:
Pre-order links are available, where applicable based upon the Requisition Type, 
on both the Firm Order Process and the Supplement LSR functionality. Where 
links are present, and active (blue colored) on a form, this indicates usage is 
available to the user.
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Address Validation

The address validation link is accessed from the End User form as shown below:

If the address validation is for the AT&T 12-State Regions, Verigate will display 
the following links on an interim screen to validate the address:

 Address Validation Inquiry - Numbered

 Address Validation Inquiry - Descriptive

 Address Validation Inquiry - Unnumbered

 Address Validation Inquiry - Unnamed

 Address Validation Inquiry - TN (Telephone Number)
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Address Validation - Output Screen with the Applicable 
Links
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Upon selection of one of the above links, the user will then receive the following 
screen:

Address Validation by TN used as an Example
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After the user enters the applicable information and clicks on Validate Address, 
the following screen will be returned if it is a successful validation.
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The user will then hit the Submit to LEX button, which will close the Verigate 
screen and send the validated address information to LEX, which will populate 
the applicable End User address fields, which are:

 SANO

 SASN

 SATH

 SASF

 SASD

 SASS

 LD1

 LV1

 LD2

 LV2

 LD3

 LV3

 AAI

 CITY

 STATE

 ZIP

Note:
Definitions of these fields may be found in the Appendix Fields and Descriptions 
of the Verigate User Guide.

Note:
All of these fields that are populated by the Address Validation Inquiry are edit-
able and the values can be changed by the user. However, it is highly recom-
mended that these fields not be changed as they represent the validated address 
and other Pre-order inquiries will or may be dependent upon this information.
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With that transaction, all the applicable End User address fields have been 
populated for the user as shown below:
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If the address validation is for the AT&T Southeast Region, Verigate will display 
the following links on an interim screen to validate the address:

 Address Validation Inquiry - Numbered

 Address Validation Inquiry - Descriptive

 Address Validation Inquiry - Unnumbered

 Address Validation Inquiry - TN (Telephone Number)

• If this option is clicked on the input screen, Verigate will pre-popu-
late the TN entered by the user on the Create LSR screen in LEX.

The Verigate screens shown for the AT&T 12-State address validation are the 
same for the AT&T Southeast Region.

The user will then hit the Submit to LEX button, which will close the Verigate 
screen and send the validated address information to LEX, which will populate 
the applicable End User address fields, which are the same as the AT&T 12-State 
Regions, with the addition of the ACTL and LSO fields.

Note:
Definitions of these fields may be found in the Appendix Fields and Descriptions 
of the Verigate User Guide.

Note:
Both of these fields, as with the other core address fields, are editable and can be 
changed by the user in overtyping the existing value. These fields are returned as 
part of the validated address process and caution should be exercised in changing 
these values.
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For the AT&T Southeast Region, if a value is returned for the QSTN response 
field, the value will be displayed as a hyperlink. If the user clicks on this link, 
Verigate will do the following:

 Verigate will store the QSTN value for use if the user initiates a TN 
Reservation transaction from LEX.

 After the user has initiated the Verigate TN Inquiry transaction from LEX and 
a list of available TNs has been returned to Verigate, the QSTN originally 
populated on the address validation response screen will be listed as the first 
TN available for the user to reserve.

When a value of ‘Y’ is returned for the QS field, a new hyperlink labeled “Accept 
Quick Service TN” will be added to the top of the address validation response 
screen, which, when clicked will initiate the same actions that occur when the user 
clicks the QSTN as described directly above.
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TN Reservation

The TN Reservation link requires an address validation to be done prior to this. It 
is available for some of the Core Products, Requisition Types E, F and M, and also 
can be done on a Supplemental Type 2 or 3 or Supplemental Type 4 or 5. 

The TN Reservation Link (or Select TN) is accessed from the product form as 
shown below:
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If the user clicks on the link titled “Select TN” on the appropriate LEX product 
form, Verigate will initiate the following process to reserve a TN:

 Verigate will display the following links on a new interim screen regardless of 
whether the TN inquiry/reserve is for the AT&T 12-State Region or AT&T 
Southeast Region.

 TN Inquiry - Random

• If clicked and the request is for the AT&T Southeast Region, Veri-
gate will display the existing Southeast Region random TN inquiry 
input screen.

• If clicked and the request is for the AT&T 12-State Regions, Ver-
igate will display the existing 12-State random TN inquiry input 
screen.

 TN Inquiry - Specified

• If clicked and the request is for the AT&T Southeast Region, Veri-
gate will display the existing Southeast Region specified TN 
inquiry input screen.

• If clicked and the request is for the AT&T 12-State Regions, Ver-
igate will display the existing 12-State specified TN inquiry input 
screen.

TN Reservation Inquiry - Output screens
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For the AT&T Southeast Region, there are additional functions that Verigate will 
provide. Verigate will display the following read-only field below the “Retrieve 
Available TNs” button.

 Existing Account Telephone Number - This field will be displayed when the 
ACT passed from LEX is ‘C’ or an ACT/MI combination of ‘V/B’ or ‘V/C’ is 
passed.

Verigate will display the following fields below the “QR” field.

 Add previously Reserved TNs

• After the user clicks the “Retrieve Available TNs” button, Verigate 
will display the TNs entered in this field as the first TNs available to 
reserve, directly above the TNs returned on the inquiry response. 
For example, if the user populates 4 TNs in the “Add Previously 
Reserved TNs” field and chooses a QR of 8, Verigate will display 
12 TNs available to reserve, the 8 returned from the inquiry and the 
3 entered in this field.

• This field should be displayed for all activity types and and may 
repeat 25 times.

 Add Other Existing TN

• Optional text field of data characteristics 10N, which repeats 25 
times.

• After the user clicks the “Retrieve Available TNs” button, Verigate 
will display the TNs entered in this field as the first TNs available to 
reserve, directly above the TNs returned from OBF on the inquiry 
response. For example, if the user populates 4 TNs in the “Add Pre-
viously Reserved TNs” field and chooses a QR of 8, Verigate will 
display 12 TNs available to reserve, the 8 returned from the inquiry 
and the 4 entered in this field.

• This field will be displayed for all ACTs.
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Verigate will display three radio buttons to the left of each reserved TN and 
present the value within the screen according to the following rules:

 Select as ATN

• Allow users to populate this radio button for all ACT/MI combina-
tions passed from LEX.

 Select as NATN

• Allow users to populate this radio button when the ACT/MI combi-
nation is ‘V/B’ or ‘V/D’ or the ACT is ‘C’.

 Select as NAN

• Allow users to populate this radio button when the ACT/MI combi-
nation is ‘V/A’ or ‘V/B’.

There are four possible sources for the TNs that will be displayed for the user to 
try to reserve. These sources are the available TNs returned to Verigate from the 
Pre-order backend on the TN inquiry request, the QSTN optionally selected by the 
user on the Verigate validated address response screen, the “Add Previously 
Reserved TNs” optionally entered by the user on the TN inquiry screen, and the 
“Add Other Existing TNs” optionally entered by the user on the TN inquiry 
screen. All of these TNs will appear available to reserve, however, only a grand 
total of twenty-five (25) TNs may be reserved. If the user attempts to reserve more 
than 25 TNs, Verigate will display the following pop-up message to the user: 
“Maximum of 25 Telephone Numbers allowed to be reserved”.

For all regions, a button labeled “Submit to LEX” will appear as the last button 
under the table of available TNs on the TN reservation screen, which, if clicked, 
will pass the reserved TNs to LEX and close the Verigate window. The “Submit to 
LEX” button will not be enabled until after at least one TN has been reserved by 
the user. LEX populates the reserved TNs in the appropriate LEX TN field on the 
LNUM(s) fields. The TN on the LNUM remains editable.
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PIC/LPIC

The PIC/LPIC link requires an address validation to be done prior to this. It is 
available for some of the Core Products, Requisition Types E, F and M, and also 
can be done on a Supplemental Type 2 or 3 or Supplemental Type 4 or 5.

The PIC/LPIC link is accessed from the product form as shown below:

If the TN is in the 12-State Regions, run the 12-State PIC/LPIC transaction to 
retrieve the PICs and LPICs. If successful, display the 12-State PIC/LPIC 
response screen.

If the address is in the AT&T Southeast Region, run the Southeast Region 
PIC/LPIC transaction to retrieve the PICs and LPICs. If successful, display the 
Southeast Region PIC/LPIC response screen.
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Regardless of whether the successful response is for a 12-State or 9-State 
transaction, display all PICs and LPICs as hyperlinks, which, if clicked, will cause 
the chosen PIC or LPIC to be displayed in text fields labeled “PIC” and “LPIC”, 
respectively. To the right of these two fields, a button labeled “Submit to LEX” 
will be available, which, if clicked, will send the PIC and/or LPIC value(s) to 
LEX and close the Verigate window. The two text fields and associated button 
should appear in two places on the screen, just above the table of PICs and just 
below the table of LPICs.

The PIC and/or LPIC are then populated within LEX on that LNUM and remain 
editable.

PIC/LPIC Inquiry - Output Screens
Proprietary - Not for use or disclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities
of this AT&T Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and AT&T Inc. Additional or external use is strictly prohibited. 
© 2002-2006. AT&T Knowledge Ventures. ALL RIGHTS RESERVED. 

4.17



Pre-Order Integration
PIC/LPIC4
Proprietary - Not for use or disclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities
of this AT&T Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and AT&T Inc. Additional or external use is strictly prohibited. 
© 2002-2006. AT&T Knowledge Ventures. ALL RIGHTS RESERVED. 

4.18



Pre-Order Integration
Features 4
Features

The Select Features link requires an address validation to be done prior to this. It 
is available for some of the Core Products, Requisition Types E, F and M, and also 
can be done on Supplemental Type 2 or 3 or Supplemental Type 4 or 5.

The Features link is accessed from the product form as shown below:

If the TN is in the 12-State Regions, run the 12-State Feature Availability 
transaction. If successful, display the 12-State Feature Availability response 
screen.

If the address is in the AT&T Southeast Region, run the Southeast region Feature 
Availability transaction. If successful, display the Southeast Feature Availability 
response screen.

Regardless of whether the successful response is for the 12-State or Southeast 
Feature Availability transaction, display a checkbox next to each row of data in 
Proprietary - Not for use or disclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities
of this AT&T Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and AT&T Inc. Additional or external use is strictly prohibited. 
© 2002-2006. AT&T Knowledge Ventures. ALL RIGHTS RESERVED. 

4.19



Pre-Order Integration
Features4
the Feature Detail table. The user may check as many of the boxes as he or she 
wishes.

A button labeled “Submit to LEX” should appear directly above and directly 
below the table of features, which, if clicked, will send the checked features to 
LEX and close the Verigate window.

LEX will populate the selected features on the service product form for each 
LNUM.

 Populate ‘N’ in the FA field.

 Populate the feature in the Feature field.

 Leave the Feature Detail field blank

 Provide for rows of FA, Feature, and Feature Detail based on the quantity of 
features selected.

If an error response is returned, Verigate will display the appropriate standard 12-
State or Southeast error response screen and will not send the response to LEX to 
display.
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Features Inquiry - Output Screen
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View CSR

The View CSR link is located on the End User form. For the AT&T 12-State 
Regions, the CSR will be retrieved based upon the main Telephone Number from 
the LSR. For the AT&T Southeast Region, the CSR will be retrieved based upon 
the Telephone Number entered in the Create LSR screen and/or either the ATN or 
AN. It is available for all Core Products, Requisition Types A, B, C, E, F, M and J 
and can also be done on a Supplemental Type 2, 3 or Supplemental Type 4, 5.

The CSR link is accessed from the product form as shown below:

If the user clicks on the link titled “View CSR” on the appropriate LEX form, 
Verigate will initiate the following process to retrieve a CSR:

Verigate will display the following links on a new interim screen regardless of 
whether the TN is for the Southeast or 12-State Regions.
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Verigate will display the same Letter of Authorization (LOA) field that appears on 
the existing CSI input screen.

 If the user clicks on the “No” radio button, display the pop-up message, “Not 
authorized to view data”.

 If the user clicks on the “Yes” radio button, run the CSR transaction using the 
TN passed to Verigate from LEX. Verigate will not have to pass any of the 
CSR data to LEX.

• If the TN is for the 12-State Regions, run the 12-State “Both CSI 
Plus Listings” CSI transaction.

• If the TN is for the Southeast Region, run the Southeast “Unparsed 
CSR by ATN” transaction.

View CSR Inquiry - Output Screens
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Due Date Calculation

The Due Date Calculation link is located on the LSR Admin form and is only 
applicable for the AT&T 12-State Regions. This link directly accesses the current 
AT&T 12-State Verigate Due Date Inquiry, which can be done by either a 
Validated Address or by REQNUM. This is also available for Supplemental Type 
2 and 3. The selected due date is not automatically populated on the LEX screen.

The Due Date Calculation link is accessed from the LSR Admin form as shown 
below:

If the user clicks on the link titled “Due Date Calculation” on the appropriate LEX 
form, Verigate will display the existing 12-State Due Date selection type input 
screen. LEX will pass Verigate the validated address if available. Once the user 
has been navigated to this screen, the Due Date transaction should function 
exactly as it currently does.
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Due Date Calculation - Output Screens
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For the AT&T Southeast Region users, this hyperlink will allow the user to view 
the tentative due date (Pre-FOC information) when LSR is in Processed status. 
This information will be displayed in the MSGID and MSGTEXT fields.
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On an LSR that has a status of “Processed”, the Due Date Calculation link is 
active. When clicked on, the following browser will be opened with the applicable 
information:

Clicking the “OK” button will return the user to the LSR ADMIN form.
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New LSRs

The first time you log into LEX with your user ID, there are no LSRs in the 
system that match your user ID. You need to either create a new LSR or view the 
LSRs of other users. You create new LSRs using the New LSR option located on 
the File menu. Detailed steps follow. To view the LSRs of another user, use the 
Search option located on the View menu and designate the user ID as your 
search criteria. For more information, see Searching for LSRs.

Creating a new LSR

Note:
In this section, the method of creating LSRs by entering all new information is 
described. You can also create LSRs by copying templates or existing LSRs and 
supplying a new PON. To create an LSR using either of these methods, you use the 
Copy LSR action, not New LSR. For more information, see “Copying LSRs” in 
this chapter.

Each new LSR you create will be added to the region in which you’re currently 
working. This region is known as the active region and is displayed directly above 
the LSR Header. You cannot create LSRs outside the active region without first 
changing regions. For more information, see Changing Regions of Operation in 
this chapter. 

1. From the File menu, select New LSR. (AT&T 12-State Regions)
LEX prompts you to enter information about the request. 
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2. Type a unique PON.
PONs (purchase order numbers) may not be duplicated in the LEX database. LEX 
will notify you if you enter a duplicate PON.

Note:
The format of the PON is not restricted by LEX. However, downstream OSSs may 
have PON-format requirements that determine whether an LSR is successfully 
processed. Consult your LSOR or LEX’s online help for more information about 
PON requirements.

PONs that include lowercase letters are accepted by LEX. However, LEX converts 
all lowercase letters to uppercase letters when the PON is saved.

3. Select a Service Type from the drop-down box. 
After you make a selection, the Activity Type drop-down box displays with a 
default selection.

4. Select a different Activity Type if necessary.
The list of activity types available to you is dependent upon the request type 
you’ve selected.
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5. AT&T Southeast Region Create LSR Screen.

With the selection of the PON, Service Type and Activity Type, the remainder of 
the fields will become active, and based upon the combination of the two above 
types, will need to be completed.

 Company Code - drop down field that contains all of the company codes for 
that particular userid.

 Type of Service - the TOS values for the Service Type selected will be 
displayed.

 AREA - drop down field that contains all of the states within the AT&T 
Southeast Region.
Proprietary - Not for use or disclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities
of this AT&T Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and AT&T Inc. Additional or external use is strictly prohibited. 
© 2002-2006. AT&T Knowledge Ventures. ALL RIGHTS RESERVED. 

5.3



Processing Local Service Requests
New LSRs5
 Migration Indicator - drop down field that is contingent upon the selection 
made in the Service Type.

 Loop Type - drop down field that is contingent upon the selection made in the 
Service Type (applicable for Requisition Type A and B).

 Telephone Account Number - editable alpha/numeric field for a telephone 
account number to be entered.

CSR Validation checks at the LSR Create Screen.

At the LSR Create Screen, LEX interacts with Verigate to perform several CSR 
checks based on the data entered within the fields on this screen. If successful, the 
user is allowed to proceed forward to the LSR Admin Screen. If not successful, 
then Verigate will return to LEX the following error messages back to the user and 
LEX will not allow the LSR to proceed forward.

Error Messages:

 “You are not authorized to perform this action - account not owned by 
AT&T.”

 “You are not authorized to perform this action on service owned by another 
CLEC.”

 “Account does not qualify for service requested.”

 “Live account exists - Not LNPBL or LNPRL.”

 “CLEC already owns this account.”

 “Invalid class of service.”

 “You are not authorized to perform this action - account not Coin.”

If the error is returned is believed to be incorrect or not appropriate, the user 
should (1) confirm the data entered on the LSR Create Screen, and if correct, (2) 
contact the ISCALLCENTER. When contacting the ISCALLCENTER, the user 
will need to provide a screen shot of the LSR Create Screen data along with the 
error message.

6. Pre-population of fields based upon selection of values chosen in the 
LSR Create process.
With the selection of values during the Create LSR process, LEX utilizes some of 
those values to pre-populate or system generate certain fields on the LSR ADMIN 
and LSR CONTACT forms. The fields that are populated by the user are available 
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for editing and/or re-selection of another value. Field on this entry screen that are 
applicable are the following:

 Activity Type:  The value selected here is populated on the ACTIVITY TYPE 
field of the LSR ADMIN form. As this is a key field that determines what 
forms to present to the user, this is not editable.

 Company Code:  The value selected here is used to retrieve information from 
the CLEC PROFILE utility and populates the applicable contact fields on the 
END USER CONTACT form. All of these fields that are populated are 
editable. For a complete list of those fields, please refer to Appendix C, 
Volume II of this User Guide.

 Type of Service:  The value selected here is populated on the TOS field of the 
LSR ADMIN form. This field is editable. When the value of “OTHER” is 
selected, the TOS field on the LSR ADMIN form will be populated with 
spaces, allowing the user to enter any TOS value in that field. For Requisition 
Type C, the default will be “OTHER”, requiring no action by the user to 
select. For other Requisition Types, the value of “OTHER” will be available 
as a selection amongst the values.

 Migration Indicator:  The value selected here is populated on the MI field of 
the LSR ADMIN form. Although editable, it is not recommended that this 
field be changed as it may impact some functionality present on the Telephone 
Number Reservation screen when selected.

Note:
For Requisition Type C, Single Port, the MI field will have a default value of 
“BLANK”. The value of the default value will be a BLANK. User does not have to 
select the value as it will be carried forward to the MI field on the LSR ADMIN 
form.

 Loop Type:  Applicable for Requisition Types “A” and “B”, the value selected 
here is used to populate the NC (Network Channel Code), NCI (Network 
Channel Interface Code), SECNCI (Secondary Network Channel Interface 
Code), and the SPEC (Service and Product Enhancement Code) fields. Where 
there is no value for that particular Loop Type, the value is blank. These fields 
allow the value to be edited and/or re-selected should the value be part of a 
drop down list. Where the value of “OTHER” is selected as a Loop Type, the 
values in all four fields mentioned above (NC, NCI, SECNCI, and SPEC) are 
BLANK and the user can enter the appropriate values in any of these fields.

 Telephone Account Number:  Once selected, that Telephone Number, under 
certain scenarios, is used to populate the applicable ATN (Account Telephone 
Number) on the LSR ADMIN form. It is also used when an Address 
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Validation is done by Telephone Number. It is not recommended that this TN 
be changed once entered on the LSR Create screen.

Note:
For Requisition Type C, Single Port, the Telephone Account Number entered on 
the LSR Create Screen will pre-populate the AN field on the LSR ADMIN form.

As mentioned above, fields that are pre-populated and/or system generated and 
are in active fields, are subject to be editable or re-selected with another value.

AT&T Southeast Region

Note:
As part of Requisition Type C, Single Port, the Service Center (SC) field on the 
LSR ADMIN form is optional, defaulted to BLANK, and no longer a Green Label 
field.

AT&T 12-State Regions

Note:
As part of Requisition Type C, Single Port, the Service Center (SC) field on the 
LSR ADMIN form and the Initiator Contact (INIT) field on the LSR CONTACT 
form are now optional and no longer Green Label fields.

7. Click OK. 
The LSR form, Admin section opens in the LSR Workspace, and the LSR is 
placed in edit mode. Information is displayed in the LSR Header, and the LSR 
Tree displays the PON with its required and optional forms. The forms that are 
displayed are dependent upon the LSR’s Service Type / Activity Type 
combination.
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Note:
For the AT&T Southeast Region, the Account Features tab is not applicable.
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8. Type the data in the appropriate fields. 
Your Local Service Ordering Requirements (LSOR) can assist you in determining 
required fields to enter in an LSR based on the Service Type and the Activity 
Type of your LSR. See Related Information in Chapter 1, About This Guide for 
details. If you have a question about how to complete a particular field, locate the 
field in LEX’s online help system. Steps for finding field-specific information are 
provided in Field-level Help of Chapter 2, Introduction.

While entering data to create an LSR, you can also copy, add, and delete form and 
section line numbers using the navigation buttons in the LSR Tree. As you add 
and delete line numbers, the quantities in the LSR Tree, which are displayed in 
parentheses, are updated. For more information about adding, copying, and 
deleting, see the sections Adding a line number, Copying a line number, and 
Deleting a line number in Chapter 3, Getting Started.

9. To save the new LSR, select Save from the File menu. 

10. To finish creating the LSR, select Close Edit from the Actions menu. 
Choosing Close Edit tells LEX that you’re finished entering information. LEX, in 
turn, releases the LSR from your exclusive use, allowing another user to change it 
if necessary. 

Upon selecting Close Edit, LEX prompts you to save the LSR. If you choose not 
to save, LEX’s action is determined by whether or not the LSR has ever been 
saved. If it has been saved and you choose not to save upon closing, all changes 
since the last time you saved will be lost and the LSR is placed in view-only 
mode. If you have never saved the LSR and choose not to save when you close 
edit mode, the LSR will be discarded, making the PON available for the creation 
of a future LSR. You are then returned to the Welcome workspace.

If you’d like to issue the LSR, see Issuing LSRs in this chapter for instructions. 
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Editing LSRs

When you select an LSR, it’s opened for viewing only, making the information 
unavailable for change. To make changes, you must place the LSR in edit mode 
by selecting the Edit LSR option from the Actions menu. This locks the LSR for 
your exclusive use. Other users can only view the LSR while you have it locked in 
edit mode. They cannot change it. When you’re finished making changes, you 
need to close edit mode to release the LSR, allowing other users to change it if 
necessary. Close Edit is also located on the Actions menu.

Editing an LSR

Warning:
Do not exit LEX using the Close (X) button in the upper corner of the LEX 
browser window. When LEX is closed this way, browser constraints prevent 
LEX from checking for unsaved data. As a result, unsaved changes made dur-
ing edit mode will be lost.

1. Search for and select an LSR with a status of New or Template.
For detailed search instructions, see Using LEX’s Search Option in this chapter.

2. From the Actions menu, select Edit LSR.
The system displays a confirmation message.

PON
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3. Verify that the correct PON is displayed and click OK. If the PON is 
incorrect, click Cancel.
LEX places the LSR or LSR template in edit mode. Fields that were inactive 
because the LSR was view-only are activated so that you can make selections or 
type in them.

Note:
For the AT&T Southeast Region, the Account Features tab is not applicable.

If you selected a template to edit, the following fields will be inactive:

 DDD (Desired Due Date)

 DDDO (Desired Due Date Out)

 DFDT (Desired Frame Due Time)

Note:
While you’re editing an LSR or LSR template, you can select Clear Optional 
Forms or Close Edit from the Actions menu. All other actions are unavailable. 
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4. Make the necessary changes.
You can type in fields, copy/cut and paste data from field to field, make selections 
from drop-down boxes, and clear optional forms. Copying and pasting text and 
cutting and pasting text are discussed in the sections, Copying text from one field 
and pasting it in another and Cutting text from one field and pasting it in another. 
For more information about clearing forms, see Clearing Optional Forms later in 
this chapter.

When you complete a field, LEX checks whether the data you’ve entered is in the 
format LEX requires. Some phone number fields, for example, accept only 
numbers as valid data; they do not accept letters. Similarly, date fields accept only 
legitimate calendar dates. This means an erroneous date such as 2/31/01 will not 
be accepted. If you enter invalid data in a field, LEX prompts you to correct your 
entry. After the correction is made, you are allowed to continue editing.

While editing an LSR, you can also copy, add, and delete form and section line 
numbers using the navigation buttons in the LSR Tree. As you add and delete line 
numbers, the quantities in the LSR Tree, which are displayed in parentheses, are 
updated. For more information about adding, copying, and deleting, see the 
sections Adding a line number, Copying a line number, and Deleting a line 
number in Chapter 3, Getting Started.

5. When you’re finished editing the LSR, select Save from the File menu to 
save your changes.

6. Select Close Edit from the Actions menu.
The LSR is returned to view-only mode, making it available for editing by a 
different user. 
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Edit shortcut menus
LEX allows you to select, cut or copy, and paste field information from one field 
to another using shortcut menus. This feature is especially helpful when you are 
using the AT&T Verigate system and want to copy existing service and address 
information. 

Shortcut menus provide edit options when you right-click in a text-entry field. 
Cut, Copy, and Paste options are available for fields that contain selected text. 
Text is selected by double-clicking or using the shortcut menu’s Select All 
option. The options are not available for inactive fields.

Note:
The Undo option can be used to reverse your last text-editing action. For exam-
ple, if you paste data into an incorrect field, immediately selecting Undo from the 
shortcut menu will remove the data from the field. Or, if you type in a field, it will 
remove the last letter you typed.

Copying text from one field and pasting it in another
You may copy data from field to field within LEX or from fields outside LEX 
(e.g., Verigate) to LEX. Be certain the fields represent the same information. For 
example, if the street address is separated into a field for number and a field for 
street name, you won’t want to paste the entire street number and name in the 
street name field. 

1. Place your cursor in the field you want to copy.

2. Double-click to select all data in the field.

When text is selected, 
the edit options are 
activated.

Right-clicking a 
field opens a 
shortcut menu 
with edit options.
5
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3. With your cursor still in the field to be copied, right-click to open the 
shortcut menu. Then, select Copy.
This places a copy of the field’s data on the Windows clipboard.

4. Place your cursor in the field where you want to paste the data.

5. If the field is not blank, double-click to select all data in the field. 

6. With the cursor on any selected text, right-click again to reopen the 
shortcut menu. Then, select Paste. 
This places the data on the clipboard in the field, replacing any selected text in the 
field. You can paste the data multiple times.

Note:
You may use keyboard shortcuts to copy and paste data. For shortcut key informa-
tion, go to your Windows help Index and type “Keyboard Shortcuts.”

Cutting text from one field and pasting it in another
In LEX, you may remove data from one field to paste into a different field by 
cutting the data. Use this feature only when you want to move data between fields. 
If you want to duplicate data, use the previous procedure, Copying text from one 
field and pasting it in another.

1. Place your cursor in the field you want to cut.

2. Double-click to select all data in the field.

3. With your cursor still in the field, right-click to open the shortcut menu. 
Then, select Cut.
This removes the data from the field and places a copy of the data on the Windows 
clipboard.

When text is selected, 
the edit options are 
activated.

Right-clicking a 
field opens a 
shortcut menu 
with edit options.
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4. Place your cursor in the field where you want to paste the data.

5. If the field is not blank, double-click to select all data in the field. 

6. With the cursor on any selected text, right-click again to reopen the 
shortcut menu. Then, select Paste. 
This places the data on the clipboard in the field, replacing any selected text in the 
field. You can paste the data multiple times.

Note:
You may use keyboard shortcuts to cut and paste data. For shortcut key informa-
tion, go to your Windows help Index and type “Keyboard Shortcuts.”

Copying text from one application to another
Like LEX, the AT&T Verigate system is an AT&T OSS. It is used for pre-ordering 
activities. Using Verigate, you can view existing service records, verify address 
information, or reserve a telephone number, for example. Using LEX’s edit 
features, you can copy existing service and address information from the Verigate 
system and paste it into the appropriate fields in LEX. For access to Verigate, 
contact your Account Manager.

1. Close all Windows applications currently running on your PC.

2. Log on to the Toolbar application. 
For instructions, see Chapter 3, Getting Started, Accessing LEX.

3. On the Toolbar, click the Lsr EXchange icon to open LEX and the 
Verification Gateway icon to open Verigate.

When text is selected, 
the edit options are 
activated. Right-clicking a 

field opens a 
shortcut menu 
with edit options.
5
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4. Maximize both applications. 
The Maximize button is the middle button in the set of three buttons that’s in the 
upper right-hand corner of each window.

5. Close the Toolbar.

6. Right-click a blank area on your Windows taskbar.
The Windows taskbar is the bar at the bottom of your desktop that has the Start 
button on it. Other buttons that represent programs currently running on your 
computer also appear on this bar. When you click the taskbar, a shortcut menu 
opens.

7. Select the Tile Horizontally option. 
The windows of both applications display one above the other. You may work in 
either application, copying and pasting data as needed, one field at a time. Refer to 
the preceding instructions, Copying text from one field and pasting it in another 
for details.

Note:
If you have more than the LEX and Verigate applications open when you perform 
this step, all open applications will tile horizontally. If this happens, close the 
other applications and repeat Steps 6 and 7.

Close

Maximize

Minimize

Right-click a blank area on the Taskbar 
to open a shortcut menu.

Tile Windows Horizontally option
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Closing edit mode
Only one user at a time can edit an LSR. This means that when you have an LSR 
in edit mode, other users can only view it. They cannot make changes to it. For 
this reason, you need to close edit mode when you’re finished making changes. 
By closing edit mode, you release the lock on the LSR so that another user can 
edit it, and you’re returned to view-only mode. 

To close edit mode, select Close Edit from the Actions menu. Close Edit is only 
available when you’re editing an LSR.
Proprietary - Not for use or disclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities
of this AT&T Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and AT&T Inc. Additional or external use is strictly prohibited. 
© 2002-2006. AT&T Knowledge Ventures. ALL RIGHTS RESERVED. 

5.16



Processing Local Service Requests
Saving LSRs 5
Saving LSRs

Saving your work
As you work in LEX, you’ll need to regularly save your work. As a rule, you 
should stop to save as soon as you’ve entered more information than you care to 
lose to a power outage or other unforeseen difficulty.

To save your work, select Save from the File menu.

LEX reminders
LEX helps you protect information by reminding you to save your work. When an 
LSR is in edit mode, certain actions will cause LEX to prompt you to save the 
LSR so that you don’t lose data. LEX reminds you to save when you attempt to 
perform any of the following actions:

 Close edit mode for the selected LSR.

 Create a new LSR.

 Select the Search option.

 Choose the Inbox view.

 Exit LEX.

Click OK to save the LSR. Otherwise, click Cancel to discard any changes to the 
LSR.

Warning:
Browser constraints prevent LEX from checking for unsaved data when the 
Close (X) button in the upper corner of the LEX browser window is clicked. 
Attempting to exit LEX via the X button will result in the loss of unsaved 
changes.
Proprietary - Not for use or disclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities
of this AT&T Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and AT&T Inc. Additional or external use is strictly prohibited. 
© 2002-2006. AT&T Knowledge Ventures. ALL RIGHTS RESERVED. 

5.17



Processing Local Service Requests
Using LEX’s Search Option5
Using LEX’s Search Option

Search criteria
LEX’s Search option allows you to use a specific set of criteria to search for 
LSRs throughout your company. It provides search fields that correspond to the 
fields found on LSRs and notifications:

Complete one or more of these fields to specify your search criteria. LEX 
compares your entries to the data in fields of all LSR forms and notifications 
(except Provider Notifications) with the same names as the search criteria fields. 
The PONs of those LSRs or notifications containing matching data are added to 
the list of LSR Search Results. Thus, the search criteria act as filters, reducing the 
complete list of LSRs in your system to a smaller, more specific list.

Except in the case of the Order Number criterion, LEX checks only fields 
having the same names as the search criteria. For example, FECCKT is not 
checked when the ECCKT criterion is specified. This means if your entry in 
ECCKT does not match the data in an LSR’s ECCKT field, the LSR will not be 
added to the Search Results list even if the entry matches the data in FECCKT. 

By contrast, when you conduct a search using Order Number, LEX checks all 
order number fields, regardless of their exact names, although order number fields 
generally have names ending in ORD. For example, NPORD and RORD are order 
number fields. During a search, LEX checks the contents of both these fields 
against the Order Number criterion. If matching data is found in either field, the 
LSR is added to the Search Results list.

Basic Search criteria Advanced Search criteria
Status
PON
User ID
Due Date Search
Last Activity Date (from/to)
End User Name
Service Type
Activity Type
SC
TN Selection
TN

SPEC
BAN1
BAN2
ATN
AN
CKR
ECCKT
Order Number
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The Due Date Search criteria field allows the user to conduct a search using the 
Desired Due Date (DDD) on the LSR ADMIN form. If the Due Date Search box 
is “checked”, this indicates that the search is for LSRs based upon the value (date) 
in the DDD field. When the box is “checked” the user should utilize the Last 
Activity Date (from/to) fields to designate the desired date range to search for. 
The Last Activity Date fields become the from and to fields for designating what 
date range to select LSRs in which the DDD falls within that range. When a date 
range is selected, all the LSRs that contain the DDD on the LSR ADMIN form 
within that range will be returned. The operation of the Last Activity Date fields 
operates in a slightly different fashion to accommodate the DDD search.

Wildcard searches
When you have only partial information as criteria for a search, you can use the 
asterisk (*) wildcard character to help find potential matches. It is used to replace 
one or more characters in text-entry fields (fields in which you type instead of 
make a selection such as PON or End User Name) to initiate open-ended 
searches. The wildcard can be placed anywhere in a field, including at its end. 
Wildcard searches are particularly helpful in cases where End User Name is 
misspelled or you only know part of a PON. The following are some examples of 
situations in which a wildcard search might be helpful:

 An end user’s name is McMillen but it may have been entered in the system 
as MacMillen. Type M*Millen in End User Name. 

 You know that the PON you want begins 88855, but are unsure what its final 
digit is. For this situation, you would type 88855* in PON.

 You want to see a list of LSRs in which the service telephone numbers have 
the same area code and exchanges beginning with the same two digits. To 
conduct this search, you use the search criteria TN Selection and TN. TN is 
activated only after you select a type from TN Selection. For this example, 
you would select TNS. Then, in the TN field, you would type the area code in 
the NPA box and 63* in the NXX box, if the digits of the exchange were 63.
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Searching for LSRs

Note:
All PONs with a Last Activity Date greater than two years old are automatically 
removed from the LEX database during regular monthly maintenance. Removed 
PONs will not be located by LSR searches. 

1. From the View menu, select the Search option. 
The Searching for LSRs dialog opens.

.

Standard 
Search 
Criteria

Advanced 
Search 
Criteria

(Use the scroll bar to access 
additional Advanced criteria.)
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2. Enter your search criteria by specifying one or more fields in Basic 
Search or Advanced Search, or by completing a combination of fields in 
both search categories.
The search criteria you enter will be used to find all matching LSRs, as described 
in the section, Search criteria. Typing a PON in PON will result in a list of LSRs 
having the same PON, that is, a list of all versions of the PON. If you want a list of 
all Template LSRs, select Template from the Status drop-down box. The system 
then checks each LSR and lists those that have Template in the Status field. 

You might choose to further narrow the Template search by locating all Resale 
Templates. To accomplish this search, you would select Template from Status 
and select Resale from the Service Type drop-down box. The more criteria you 
supply for a search, the more detailed the search, and generally the fewer LSRs 
that are returned in the Search Results window. Wide-ranging search criteria 
will return large numbers of LSRs and may affect your response time. 

Note:
You can use wildcards for your search in any text-entry field, such as PON or End 
User Name. The End User Name field is not case-sensitive. For more informa-
tion about wildcards, see the section “Wildcard searches.”

3. From Select Lines Per Page, select the number of LSRs to appear on 
each page of the Search Results window.
The number you select is the maximum number of matching LSRs that will 
display in the Search Results window at one time. As an example, the default 
selection is fifteen, which means LEX will present LSRs in groups of up to fifteen 
at a time. If more than fifteen matches (or whatever number you’ve selected) are 
found, hyperlinks are added to the Search Results window so you can navigate 
the groups of LSRs. 

4. Click the Search button. 
The Search Results window opens. If the system did not find any LSRs 
matching your criteria, it notifies you by displaying a message in the window. 
Otherwise, all the LSRs that matched your criteria display. If more LSRs were 
found than the per-page selection you made in Step 3, navigation links are added 
to the bottom of the window. Use the navigation links to view different groups of 
LSRs. For more information, see the section Navigating search results.

5. If you would like to see the search criteria, click Show Criteria.
See the next section, Show/Hide Criteria button, for more information.
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6. Click a PON in Search Results to open the LSR in the LSR Workspace. 
LEX minimizes the Search Results window and returns you to the LEX 
Desktop window, where the LSR is displayed in view-only mode.

7. If you want to select another LSR from your search results, maximize 
the Search Results window and click another PON in the list. 

8. If you want to perform a new search, maximize the LEX Desktop 
window and return to Step 1.
The LSRs found by this new search will replace those previously listed in the 
Search Results window.

9. Once you’re finished with the LSRs in the Search Results window, close 
the window.

The Search Results window
The Search Results window is a separate browser window from the LEX 
window. This allows you to alternate between the LEX window and the Search 
Results window, selecting different LSRs to view in the LSR Workspace. 
Because it is a separate window, the Search Results window provides additional 
options. You may:

 Resize the window.

 Navigate and browse pages of search results. See Navigating search results.

 View the search criteria used to locate your search results. See Show/Hide 
Criteria button.

 Sort the LSRs by any of the columns. See Sorting LSRs.

 Print the results of your search request. See Printing search results.

Note:
If you are logged on to LEX with an Administrator ID, you can also reassign LSRs 
from the Search Results window. See Appendix B for more information.
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Note:
A new column, “LSR DDD” has been added to the Search Results screen and will 
be included on all search results regardless of search criteria entered. This col-
umn displays the due date from the Desired Due Date (DDD) field on the LSR 
ADMIN form associated with that LSR.

The Search Results window
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Navigating search results

When the number of LSRs located by a search request is greater than the number 
that can be displayed on a single page, LEX adds hyperlinks to the bottom of the 
Search Results window. The lines-per-page selection you make on the 
Searching for LSRs dialog determines how many LSRs LEX can display on a 
single search results page. Use the hyperlinks, also known simply as links, to 
navigate and browse the list of results.

This Link Displays This Search Results Page
First Page 1, regardless of which page you’re currently viewing.
Previous The page immediately before the current page. For example, 

in the following illustration, page 2 is the current page. 
Clicking Previous would display page 1.

Page Number The page that corresponds to the link number. For example, 
clicking 2 displays page 2, while 10 displays page 10.

Next The page that follows the current page. For example, in the 
following illustration, clicking Next would display page 3.

Last The very last page of search results, regardless of which 
page you’re currently viewing.

First goes to Page 1.

Previous and Next move back 
and forth through the search 
results, one page at a time.

Page numbers allow you to go 
directly to a specific page.

Last goes to the end 
of the search results. 

The number of the current page is bold. Since 
you’re already viewing the page, its number is 
not a hyperlink.

{ }
5.24
 Proprietary - Not for use or discl
reproduce, copy, and distribute the 
of this AT&T Operational Support 
Resale Agreement between the CLE
© 2002-2006. AT&T Knowledge V
osure outside AT&T Inc. except by prior writte
information solely for internal use in training emp
System (OSS) in accordance with the OSS prov

C and AT&T Inc. Additional or external use is str
entures. ALL RIGHTS RESERVED. 
n agreement. CLECs  may use,
loyees to utilize the capabilities

isions of the Interconnection or
ictly prohibited. 



Processing Local Service Requests
Using LEX’s Search Option 5
The number of page links visible on the Search Results window depends upon 
your per-page selection and the number of LSRs found. LEX retrieves up to 150 
matching LSRs at once, which it divides by the number of lines per page you’ve 
selected. This means the fewer lines per page you choose, the more page links 
you’ll see. If the located search results exceeds 150, another set of sequentially-
numbered pages is available. You advance to the next set by clicking Next. In the 
illustration above, more than 10 pages of search results are available, although 
only 10 are visible. Clicking Next, in this case, would display page 11 and any 
other available pages up to page 20. 

Show/Hide Criteria button

The Show Criteria button on the Search Results window toggles between the 
labels Show Criteria and Hide Criteria. When you click Show Criteria, LEX 
displays the criteria you selected that generated the current search results. Among 
these criteria are the beginning and ending dates of the Last Activity Date range. 
If you did not provide a date range when you selected search criteria, the 
beginning and ending dates are automatically determined. They are set to today’s 
date and January 1st of the year two years earlier. Either <All> or <Blank> is the 
value displayed for fields where you did not select a criterion from a drop-down 
list. For text-entry fields, <Blank> indicates a value was not entered. When 
you’re finished viewing the search criteria, click Hide Criteria to reset the button 
and again hide the criteria. Clicking Next or Previous to page through search 
results also resets the Show Criteria button, hiding the criteria. 

Click Show Criteria to display the search criteria.

When Show Criteria is clicked, LEX displays the selected criteria, and the 
button toggles to its alternate label. Click Hide Criteria to reset the button 
and again hide the criteria.
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Sorting LSRs

By default, LSRs in the Search Results window are sorted by Last Activity 
D/T. This creates a list in reverse chronological order with PONs having the most 
recent activity at the top of the list. Click the down arrow at the top of the Last 
Activity D/T column to reverse the sort order.

To change how the LSRs are sorted, click the up arrow at the top of another 
column. For example, if you want to view the LSRs in ascending status order, 
click the up arrow at the top of the Status column. Click the down arrow in the 
same column to view the LSRs in descending order.

When the Due Date Search is selected, that date range also appears on the 
Show Criteria display.
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Inbox
Inbox is another tool LEX provides to help you locate the LSRs you need. LEX’s 
Inbox is a predefined search that locates all of your LSRs with a Last Activity 
D/T during the previous seven days. It finds all the LSRs affiliated with your user 
ID just as if you had conducted a regular search with the criterion User ID set to 
your user ID. However, instead of completing the customary search fields, you 
can simply click the Inbox icon to get this list of LSRs.

1. To view the Inbox, select Inbox from the View menu. 
The Search Results window opens, listing all of your LSRs that have a Last 
Activity D/T during the previous seven days. The LSRs are listed by Last 
Activity D/T in reverse chronological order.

2. Click a PON to open it in the LSR Workspace.
The Search Results window provides functionality similar to defined searches. 
However, since you cannot select search criteria for an Inbox search, the Show 
Criteria button is not available. You can save the contents of your inbox to a file 
for use with other applications. For more information, see the next section, Saving 
your search results.

Click the up 
arrow to sort a 
column in 
ascending order.

Click the down 
arrow to sort a 
column in 
descending 
order.
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Saving your search results
Once you’ve performed an LSR search, you can save the search results to a file 
(export) for use in other applications, such as Microsoft Excel®. All LSRs that 
result from a search are exported to the file, including those that span several 
screens due to the per-page limit. For each of these LSRs, only the data you see in 
the Search Results window is exported to the file (i.e., PON, User ID, etc.). 
Other LSR information stored in the LEX database is not included.

Consult the online help in the application in which you will use the LSR data for 
instructions about sorting or any other issues regarding the saved file. 

1. Use the LEX Search option to display the desired LSRs in the Search 
Results window.
See Searching for LSRs in this chapter for step-by-step instructions for performing 
a search.

Note:
If your search results include more than 10,000 PONs, the time required to save 
the results can be extensive. You may want to more narrowly define your search 
criteria to limit the number of search results returned.

2. If the Search Results window has been open for an extended period of 
time, click Refresh to update the list of LSRs.
When you save your search results, LEX retrieves the most up-to-date data from 
the database. By refreshing prior to saving, you’ll see the same updated list 
onscreen that will be saved to disk.

3. Move your cursor to Save As to display the available file types.
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4. Click the type of file you want to create: Text, CSV, or Excel.
 Text: Saves the file in text-only format (ASCII), separating columns with 

spaces.

 CSV: Saves the file in comma-separated-value format, separating columns 
with commas.

 Excel: Similar to CSV, but this format is specifically designed for use with 
Microsoft Excel.

The File Download window opens.

When you place the cursor on Save As, the options 
Text, CSV, and Excel appear.
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5. Choose the Save option. 
How the options are presented may vary according to the browser version you’re 
using. Pictured above is the File Download dialog box presented by Microsoft 
Internet Explorer version 6.0. The Save As dialog box opens.
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6. Select the folder to which you want to save the file. Then, type a file 
name in the File Name field or click an existing file already in the folder 
and click Save. 
If you selected Text as the file format, you’ll need to type.txt as the file extension 
at the end of the file name. For CSV and Excel files, the extension is implied, so 
you don’t need to type it.

If you type the same name as an existing file, you will be prompted to replace it. 
After your file has been saved, LEX displays the message, “Download 
Complete.”

7. Click OK to accept the message.
If you prefer to view the newly saved file, click Open.

Note:
Included with your search results will be a summary of the search criteria that you 
selected to generate the newly saved search results. When you view or edit the 
file’s contents, you will find the search criteria listed at the beginning of the file.

8. When you’re finished working with the Search Results window, click 
the Exit button to close the window. You can then maximize the LEX 
Desktop window to continue working with the last selected LSR.

Printing search results
After you’ve completed a search, you can print all the LSRs located by the search. 
The printout will include not only the LSRs currently displayed in the Search 
Results window, but also all those located on the next and previous pages. For 
detailed search instructions, see Searching for LSRs in this chapter.

Note:
LEX reports are printed using landscape orientation. Be sure your browser has 
been set up to print in landscape mode. For more information, see “Setting your 
browser to print landscape.”

If your search results include more than 10,000 PONs, the time required for the 
system to prepare the print job can be extensive. You may want to more narrowly 
define your search criteria to limit the number of search results returned.
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1. If the Search Results browser window is minimized, maximize it.

2. The LSRs will be printed in the same order as displayed in the Search 
Results window. If you want to sort the list differently, click the 
ascending or descending sort button in the column by which you want 
to sort.

3. If you’ve had the Search Results window open for an extended period 
of time, click Refresh to update the list of LSRs.
When you print your search results, LEX retrieves the most up-to-date data from 
the database for your printout. By refreshing prior to printing, you’ll see the same 
updated list onscreen that you’ll get on your printout.

4. Click the Print tab.
A new browser window is opened, showing a preview of the report that will be 
printed. It will include a summary of the search criteria you selected to generate 
the search results list.

Click the up 
arrow to sort a 
column in 
ascending order.

Click the down 
arrow to sort a 
column in 
descending 
order.
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5. From the File menu, select Print.
All print functionality is provided by the browser you’re using. For more 
information about your browser’s print capabilities, consult its online help system. 
If you’re using Microsoft Internet Explorer, the Print dialog box provides the 
following options:

 Select a printer.

 Designate the number of copies to print. 

 Specify a page or page range to print.

6. Click OK to send the printout to your printer.

Search 
criteria

Search 
results, 
i.e., the 
LSRs 
that 
matched 
your 
criteria
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Viewing LSRs

Viewing the status of your LSRs
To view a list of recent LSRs for your user ID, you use the Inbox option. Inbox 
is a predefined search that locates all the LSRs affiliated with your user ID. 
Instead of having to define a search with your user ID, you simply select Inbox 
from the View menu. All of your LSRs with a Last Activity Date during the 
previous seven days are included.

1. From the View menu, select Inbox. 
The Search Results window opens with a list of your LSRs. 

2. To view the details of an LSR, click its PON.
The LSR is opened in the LSR Workspace of the LEX Desktop. It is set in view-
only mode so that you cannot make changes to the information. To make changes, 
you use Edit LSR on the Actions, as described in the Editing LSRs section of this 
chapter.

Also on the LEX Desktop, the LSR Tree is built. The folders and forms that are 
placed in the Tree are dependent upon the LSR’s service type and activity type. 
Other folders, containing notification information, appear in the Tree according to 
the LSR’s status and previous activity.

Viewing status information for another user
Select the Search option from the View menu to view and begin working LSRs 
under another user ID within your company. After you update an LSR associated 
with a user ID other than your own, your user ID will be affiliated with the LSR. 
This means that the Inbox view will then list the LSR as one of your own. This is 
a backup feature for those times when an individual employee is not available and 
a co-worker needs access to his or her LSRs.
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1. From the View menu, select Search. 
The Search dialog displays.

2. From the User ID drop-down box, select the ID of the individual whose 
LSRs you want to view.

3. Click Search.
The Search Results window opens, displaying a list of LSRs for the user ID 
you’ve entered.
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For more information about conducting searches and using the features of the 
Search Results window, see Using LEX’s Search Option.

4. To view and begin working one of the listed LSRs, click its PON.

Viewing an LSR

1. Conduct an LSR search.
See Searching for LSRs for step-by-step instructions.

2. In the Search Results window, click the PON you want to view.
The LSR is opened in the LSR Workspace of the LEX Desktop. It is set in view-
only mode so that you cannot make changes to the information. To make changes, 
you use Edit LSR on the Actions menu, as described in the Editing LSRs section 
of this chapter.

Also on the LEX Desktop, the LSR Tree is built. The folders and forms that are 
placed in the Tree are dependent upon the LSR’s service type and activity type. 
Other folders, containing notification information, appear in the Tree according to 
the LSR’s status and previous activity.
Proprietary - Not for use or disclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities
of this AT&T Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and AT&T Inc. Additional or external use is strictly prohibited. 
© 2002-2006. AT&T Knowledge Ventures. ALL RIGHTS RESERVED. 

5.36



Processing Local Service Requests
Viewing LSRs 5
Refreshing an LSR
To update the onscreen content of a selected LSR, select Refresh from the View 
menu. This option tells LEX to retrieve any new information that’s been added to 
an LSR by other users or by the receipt of notifications from downstream OSSs 
since you last opened it. Refresh is only available for LSRs not in edit mode. 

Viewing an LSR’s errors
When LEX first receives errors on an LSR from a 
downstream system, LEX places the LSR in Error 
status and adds an Error form to the LSR Tree. As 
long as the LSR remains in Error status, the Error 
form is available. 

Click Error to display a list of errors in the LSR 
Workspace. The list is view-only. To correct the 
errors, use the Process Errors action. For more 
information about how to process errors, see 
Processing LSR Errors in this chapter.

Error 
notification
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 Copying LSRs

The Copy LSR action allows you to create a copy of another LSR or an LSR 
template created in the same region. This action is useful when you have LSRs for 
multiple customers who, with a few exceptions, have identical information. Also, 
you may use Copy LSR when an LSR was created under the wrong Activity 
Type. This allows you to copy an LSR and change the Activity Type without 
retyping the LSR. You can also choose to copy only the administrative details of 
an LSR.

LEX determines which fields to copy to a new LSR based on Activity Type. If a 
field contains data on the original LSR, the system checks whether the field is 
active for the Activity Type of the new copy. If it’s an active field, the data will 
be copied from the original LSR, with the exception of the following fields: DDD 
(Desired Due Date), DDDO (Desired Due Date Out), DFDT (Desired Frame Due 
Time), and Date/Time Sent. Because these fields are specific to an LSR, LEX 
leaves them blank so you can enter the correct information.

Copying an LSR

1. Search for and select the LSR or template that you want to copy.
For detailed search instructions, see Using LEX’s Search Option in this chapter.

Note:
You can get a list of all your company’s templates by conducting a search with the 
criterion Status set to Template.

2. From the Actions menu, select Copy LSR. 
The Copy LSR screen displays. 
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3. Choose the type of copy you want to make, either a full copy or an 
administrative copy.

Full LSR
This option copies all LSR information in its entirety (all forms, sections, and tabs 
with data). Error, FOC, SOC, and Jeopardy notifications are excluded. 

If you’ve set up LSR templates, use this procedure to copy your template when 
you want to copy all forms in a template. 

Admin Info
This option allows you to copy only the LSR information located on the LSR 
Admin form (excluding the contents of the RPON and Account Features tabs) 
and the LSR Bill, and LSR Contact forms. End User, HGI, and service-specific 
form information are not copied. They will be blank so that you can enter 
information specific to your customer. 

If you’ve set up an LSR template with general information, use this procedure to 
copy your template. 

4. Type a unique PON for the new LSR. 

5. Activity Type is automatically set to that of the copied LSR. Select a 
different Activity Type if necessary. 

Click Copy Full LSR 
or Copy Admin Info 
to choose the type of 
copy you want.
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Note:
If you are copying an LSR to correct its Activity Type, you may want to remove the 
PON with the old Activity Type from the LEX database. For more information, see 
“Deleting LSRs” in this chapter.

6. Click OK. 
The system confirms that you want to continue by displaying a message.

7. Click OK to continue the copy process. Otherwise, click Cancel.
If you choose OK, LEX opens the new, copied LSR in edit mode, automatically 
filling the fields with the same information as the original PON. Any notification 
data is not copied. The new PON is also displayed in the LSR Tree and Header.
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8. Make any necessary changes to the LSR.
For more information about changing the content of an LSR, see Editing LSRs in 
this chapter. If you have a question about how to complete a particular field, locate 
the field description using LEX’s online help system, as described in Field-level 
Help in Chapter 2, Introduction. 

9. When you’ve finished making changes, select Close Edit from the 
Actions menu.
The Close Edit confirmation displays.

10. Select OK to save the LSR.

New PON

Status is New
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Template LSRs

The Copy LSR action allows you to create LSR templates from which other LSRs 
can be copied. You can create any number of templates in LEX. You can even 
create a template for each Service Type and Activity combination, such as Loop 
and Resale requests. In this way, creating templates helps ensure consistent 
ordering and saves key-entry time on high-volume ordering. 

Once a template has been created, it must be copied before it can be used to create 
an LSR. For instructions on how to copy a template, see the previous section, 
Copying an LSR.

Creating an LSR template

1. Create an LSR that you want to serve as the model for the template, or 
locate an existing LSR.
Create and edit the LSR as you would any other LSR. For more information, refer 
to the sections Creating a new LSR and Editing LSRs in this chapter. For detailed 
search instructions, see Using LEX’s Search Option in this chapter.

2. From the Actions menu, select Copy. 
LEX displays the Copy LSR dialog in the LSR Workspace.

Click Copy Full LSR 
or Copy Admin Info 
to choose the type of 
copy you want.

Check Copy 
Template to create a 
template.
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3. Click the copy option of the type of template you want to create:
 Copy Full LSR: This option allows you to copy all LSR information in its 

entirety (all forms, sections, and tabs with data). 

 Copy Admin Info: This option allows you to copy only the LSR information 
located on the LSR Admin, LSR Bill, and LSR Contact sections of the LSR 
form. End User, HGI, and service-specific form information will be blank so 
that you can enter information specific to your customer. 

4. Click the Template check box to place a check mark in it. 

5. Type a unique name or PON for the new LSR. 
Instead of typing a PON, you might choose to assign a name to the template that 
describes its usage. For example, if the template contains data for new loop 
installs, you might name it “LOOP INSTALL.” However, remember that the name 
or PON cannot exceed 16 letters and numbers combined.

Note:
PONs that include lowercase letters will be accepted by LEX. However, LEX will 
convert lowercase letters to uppercase letters when the PON is saved.

6. Activity Type is automatically set to that of the copied LSR. Select a 
different Activity Type if necessary. 

7. Click OK to continue.
The system confirms that you want to continue by displaying a message.

8. Click OK to create the template. Otherwise, click Cancel.
If you choose OK, LEX saves the new LSR template and displays it in the LSR 
Workspace. The fields are filled with the same information as the original PON, 
excluding notification data which is not copied. In the LSR Header, Status is set 
to Template.
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If you need to modify the template, you edit it the same way you edit a regular 
LSR. For more information about modifying LSRs, see Editing LSRs in this 
chapter. If you have a question about how to complete a particular field, locate the 
field description using LEX’s online help system, as described in Field-level Help 
in Chapter 2, Introduction. 

Status is 
set to 
Template.
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Clearing Optional Forms

The Clear Optional Forms action allows you to clear all data from one or more 
optional forms based on the Service Type and Activity Type of the selected 
LSR. It is enabled for only three types of LSRs: 

 LSRs with a status of New that have never been issued.

 LSRs with a status of New that have a supplement code of 3.

 LSRs with a status of New that are created as a result of processing errors.

When you select this action, only those forms that are optional for the selected 
LSR will be available to clear.

Clearing an LSR’s optional forms

1. Search for and select the LSR to be modified. 
For detailed search instructions, see Using LEX’s Search Option in this chapter.

2. Select Edit from the Actions menu to place the LSR in edit mode, if it’s 
not already editable.

3. From the Actions menu, select Clear Optional Forms. 
The system evaluates your selection to determine which, if any, optional forms 
exist for the Service Type / Activity Type combination. If optional forms are 
available for the combination, the Clear Optional Forms dialog opens in the 
LSR workspace. Otherwise, you receive a message notifying you that the LSR 
does not include optional forms.
Proprietary - Not for use or disclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities
of this AT&T Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and AT&T Inc. Additional or external use is strictly prohibited. 
© 2002-2006. AT&T Knowledge Ventures. ALL RIGHTS RESERVED. 

5.45



Processing Local Service Requests
Clearing Optional Forms5
4. In the LSR Workspace, click the check boxes of the form(s) you want to 
clear. If you want to clear all the listed forms, click Select All. 

5. Click OK to continue. 
The system displays a confirmation message.

6. Verify your selections and click OK to clear the selected forms. 
Otherwise, click Cancel to return to the forms list.
Clicking OK immediately clears the selected form(s) and places the LSR in edit 
mode.

7. Make any other necessary changes. 

8. When you’re finished updating the LSR, select Close Edit from the 
Actions menu. When prompted to save your changes, click OK.

Click the check boxes of 
the forms you want to 
clear. 

To clear all the available 
optional forms, check 
Select All. 
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Deleting LSRs

Delete versus Cancel
LSRs in LEX not awaiting notification or confirmation from AT&T OSSs can be 
deleted using the Delete LSR action, as described in the next section. By contrast, 
LSRs awaiting response from AT&T OSSs cannot be deleted. Instead, they must 
be canceled using the Supplement LSR action. When you submit a cancel 
request, LEX creates a supplement that notifies AT&T OSSs to cancel the original 
request for service. For step-by-step cancellation instructions, see Supplementing 
LSRs, Canceling an LSR in this chapter.

Note:
Complete Status: Only Requisition Type J LSRs or LSRs with Activity Type R can 
be deleted while in Complete status. All others must reach Post to Bill status 
before they are eligible for deletion. See “Deleting LSRs,” “Delete LSR and LSR 
statuses” for details.

LSRs with these statuses 
must be deleted:

LSRs with these statuses 
must be canceled:

New
Worked
Complete
Post to Bill
Billing Completion Notice
Fatal Error
Super Fatal
Supplement
Cancel FOC
AT&TCancel
Template

Issued
Processed
Jeopardy
FOC
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Deleting an LSR

1. Search for and select the LSR to be deleted. 
For detailed search instructions, see Using LEX’s Search Option in this chapter.

2. From the Actions menu, select Delete LSR.
LEX checks the status and version of the selected LSR. Based on status and 
version, LEX presents a confirmation message or delete options, described in the 
next step. For LSRs with the status Supplement or Worked, LEX presents the 
delete options. For all others, including Fatal, Super Fatal, and Version 1 LSRs, 
LEX displays the delete confirmation message. For more information about how 
LSR statuses affect the deletion process, see the next section, Delete LSR and LSR 
statuses.

3. If the system presents the delete options described below, choose the 
appropriate option and click Delete. Otherwise, go to the next step.
 Selected LSR only: Choose this option to delete only the selected version of 

the LSR. If the PON has other versions, whether entered by you or another 
user within your company, those will remain in the LEX database.

 Selected LSR and all previous versions: Choose this option if you want 
to delete all versions of an LSR once it’s processed error-free or when the 
LSR reaches its final status. All prior versions are deleted, regardless of user 
ID. 

 The Delete LSR confirmation message is then displayed.

4. If the correct LSR is shown in the confirmation message, click OK to 
proceed. Otherwise, click Cancel to discontinue the operation and 
locate the correct LSR. 
After you click OK, the PON will no longer display or be available in LEX.

Note:
When an LSR about to be deleted has previous versions, the following warning 
message will be presented: “You are about to delete the selected LSR and all pre-
vious versions. Please review the LSR prior to deletion to confirm that all versions 
should be deleted and none retained by the user”. The user should do a review of 
the previous versions to ensure that such versions are no longer needed.
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Delete LSR and LSR statuses
When you choose to delete an LSR, LEX checks the LSR’s status to determine 
how it should be deleted. If the LSR is a template, LEX deletes it without further 
action from you. If the LSR has a status of Cancel FOC, AT&TCancel, 
Supplement, or Worked, LEX deletes not only the selected LSR, but all prior 
versions of it, too. For New, Fatal Error, and Super Fatal LSRs, LEX lets you to 
choose whether to delete only the selected LSR or to include all prior versions as 
well, unless a cancellation has been requested. If you or another user has 
requested the cancellation of a Fatal or Super Fatal LSR, LEX deletes only the 
selected LSR, not the previous versions.

LSRs in a final processing status are also available for deletion. Directory service 
LSRs (those having the service type J-Directory Service Request) are finalized 
when they reach Complete status. Likewise, LSRs with the activity type R-Record 
Change are finalized when their status becomes Complete. For all other LSRs, 
Post to Bill, not Complete, is the final status. 

Review the following table for a summary of LSR statuses and delete activities:

* When an LSR’s supplement type is 1 (i.e., a user requested to cancel the LSR)

LSR Status What happens during Delete LSR

Template
Fatal Error*
Super Fatal*

LEX deletes only the selected LSR.

Cancel FOC
AT&TCancel
Complete
Post to Bill
Billing Completion Notice
Supplement
Worked

LEX deletes the selected LSR and all prior ver-
sions without prompting you to choose a deletion 
method.

New
Fatal Error
Super Fatal

LEX lets you choose whether to delete only the 
selected LSR or to include all prior versions.
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Issuing LSRs

By selecting Issue LSR from the Actions menu, you can issue an LSR. Issuing 
an LSR means you are releasing it for transmission to AT&T Operational Support 
Systems (OSSs) to be processed and worked.

Issuing an LSR

1. Search for and select the LSR to be issued. 
For detailed search instructions, see Using LEX’s Search Option in this chapter.

2. If the LSR is currently selected, save your changes and close the edit 
mode.

3. From the Actions menu, select Issue LSR.
The Issue LSR confirmation message displays. 

4. Click OK if the displayed PON is the LSR to be issued. Otherwise, click 
Cancel to discontinue the action. 
LEX checks the LSR for completeness. 
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5. If data is missing from any of the required forms and fields, LEX 
notifies you by displaying a message. To complete the LSR, perform 
Steps 6 - 8. If you do not receive this message, go to Step 9.

6. Click OK to accept the missing fields message.
LEX then places the LSR in edit mode and opens the window Missing Required 
Fields/Forms List. This window lists the fields that must be completed before 
the LSR will be successfully issued. With each field, the form in which the field is 
located is listed. 

7. Edit the LSR, completing the fields indicated in the Missing Required 
Fields/Forms List. 
You can keep the Missing Required Fields/Forms List open for reference 
while you edit the LSR. Click the Required Fields button on your Windows 
taskbar to view the Missing Required Fields/Forms List. Click the LEX 
button to return to the LEX Desktop. The Windows taskbar is the bar at the 
bottom of the screen with the Start button on it.

After you’ve corrected all the fields listed in the Missing Required 
Fields/Forms List, click Exit to close the window. Once you close the window 
and close edit mode, you will be unable to return to the list of missing fields until 
you attempt to issue the LSR again.

8. When you’ve finished, return to Step 2 to begin re-issuing the LSR.
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9. When all missing fields are completed, LEX issues the LSR to the OSS.
The LSR Header is updated. Status is set to Issued, which indicates that the LSR 
is waiting in a queue to be sent to the AT&T OSSs, and Last Activity Date is 
automatically updated according to the date and time you issued the LSR. This is 
the same date and time that is assigned to Date/Time Sent in the LEX database. 

Note:
If an LSR remains in Pending status for more than 15 to 20 minutes, contact the 
IS Call Center.

Warning:
An LSR may pass initial edits and be rejected by an LSC representative later in 
the process. An LSR such as this will receive a manual rejection rather than a 
mechanized rejection and will be returned to LEX with a status of Fatal Error.

LSRs unavailable for issuing
There may be instances when you want to issue an LSR, but the LSR is 
unavailable for issuing. There are two possible causes of this problem.

When a user works with an LSR in LEX, the system locks the LSR, preventing 
other users from attempting to work with it simultaneously. If you choose an LSR 
that is locked, you will be prevented from issuing the LSR. Instead, you receive a 
message, indicating that another user is working with the LSR. Click OK to accept 
the message.

In other situations, you may be prevented from issuing the LSR because it’s been 
deleted from the system by another user. The system notifies you of this situation 
by displaying a message, notifying you that no further action can be taken on the 
LSR. Click OK to accept the message and to have the LSR Header, Tree, and 
Workspace cleared.

Status changes to Issued.
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Supplementing LSRs

The supplement feature allows you to make changes to a previously issued LSR. 
The Supplement LSR action can only be performed on LSRs with the status of 
Issued, Processed, Jeopardy, or FOC. By selecting Supplement LSR, you can 
cancel an LSR, change the desired due date or appointment time information, or 
make other modifications to the LSR. The supplement process copies the LSR, 
records the supplement type, and increments the version number by one. The LSR 
is then available for updating.

Each time you supplement an LSR, the Supplement Type field (SUP) is updated 
for that LSR. Canceled LSRs have a supplement type of 1. LSRs with changed 
DDD, DDDO, APPTIMEDDD, RESID, or REMARKS have a supplement type of 
2 or 4 based upon the region. LSRs processed with other modifications have a 
supplement type of 3 or 5 based upon the region. See note below for field 
applicability.

Note:
If you choose to supplement an LSR in Issued status, the action generally will fail 
because the LSR’s status will change before the Supplement action is completed. 
Because LEX is a real-time ordering system, LSRs are passed to the downstream 
OSSs after they’re issued. The OSSs generally respond quickly, changing the sta-
tus of the LSR to Processed, Fatal Error, or Super Fatal Error. This change is evi-
dent in LEX once the LSR is refreshed.

LSRs in FOC status cannot be supplemented under certain circumstances: 
(1) if the LSR is of Activity Type R, or (2) if the LSR is of Requisition Type J in the 
AT&T Southwest Region.

Note:
For the AT&T Southeast Region, the following fields are editable based upon the 
Supplement Type:

 Supplement Type 1 - REMARKS field is editable.

 Supplement Type 4 - DDD, DDDO and REMARKS fields are editable.

 Supplement Type 5 - All other fields including REMARKS.
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For the AT&T 12-State Regions, the following fields are editable based upon the 
Supplement Type:

 Supplement Type 1 - No fields are editable.

 Supplement Type 2 - DDD, DDDO APPTIMEDDD, RESID and REMARKS 
are editable.

 Supplement Type 3 - All other fields including REMARKS.
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Modifying an issued LSR
Use this procedure to make changes to previously issued LSRs with the status of 
Issued, Processed, Jeopardy, or FOC. If you need to make changes to a New or 
Template LSR, follow the instructions in Chapter 5, Processing Local Service 
Requests, Editing LSRs. 

1. Search for and select an LSR with a status of Issued, Processed, 
Jeopardy, or FOC.
For detailed search instructions, see Using LEX’s Search Option in this chapter.

2. From the Actions menu, select Supplement LSR.
LEX presents the Supplement LSR dialog.

3. Click the option Other Changes.
The system displays a confirmation message.

4. Verify that you’ve selected the correct PON and click OK. If the PON is 
incorrect, click Cancel to discontinue supplementing.
LEX copies all data from the LSR (excluding notification data) to a new version 
and places it in edit mode. Data in the LSR Header is updated. Status is set to 
New and the LSR’s version number is incremented. For example, if you chose to 
supplement version 2 of an LSR, the new version created during the supplement 
action would be version 3. The status of the supplemented LSR (version 2 in this 
example) is set to the status Supplement. 
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Note:
The Other Changes option of Supplement LSR sets the value of an LSR’s sup-
plement type to 3.

5. Make your modifications to the new LSR. 
For modification instructions, see Editing LSRs, Editing an LSR in this chapter.

6. From the Actions menu, select Close Edit.
LEX displays a message for you to confirm that you want to save your changes 
and set the LSR back in view-only mode.

7. Click OK.

8. If the LSR is ready to be reissued, select Issue from the Actions menu. 
See Issuing LSRs in this chapter for more information.

Version is 
incremented.

Status is New.
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Changing due date and appointment data

Note:
This section does not apply to Requisition Type J LSRs. The Change Due 
Date/APPTIME Data option is unavailable when supplementing Type J LSRs.

When the Change Due Date/APPTIME Data option of the Supplement LSR 
process is selected, only certain LSR fields are editable. You may modify: 

 Desired Due Date (DDD)

 Desired Due Date Out (DDDO)

 Appointment Time DDD (APPTIMEDDD)

 Response Identifier (RESID)
 Remarks

Note:
For the AT&T Southeast Region, only DDD, DDDO and REMARKS would be 
applicable for Supplement Type 4. For Supplement Type 1, only the REMARKS 
field is editable as needed. Throughout this section where it references either of 
these two Supplement Types (1 or 4), only these sets of fields are applicable.

If you need to change any other fields, use the Other Changes option as 
described in the previous section, Modifying an issued LSR.

1. Search for and select an LSR with a status of Issued, Processed, 
Jeopardy, or FOC.
For detailed search instructions, see Using LEX’s Search Option in this chapter.

2. From the Actions menu, select Supplement LSR.
LEX presents the Supplement LSR dialog.
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3. Click the option Change Due Date/APPTIME Data.
The system displays a confirmation message.

4. Verify that the correct PON is displayed and click OK. If the PON is 
incorrect, click Cancel to discontinue supplementing.
LEX copies all data from the LSR (excluding notification data) to a new version. 
This new version is placed in edit mode, but only the following fields are 
accessible: DDD, DDDO, APPTIMEDDD, RESID, and REMARKS. All other 
fields are inactive. 

The data in the LSR Header is updated. Status is set to New and the LSR’s 
version number is incremented. For example, if you chose to supplement version 
2 of an LSR, the new version created during the supplement action would be 
version 3. The status of the supplemented LSR (version 2 in this example) is set to 
the status Supplement. 

Click the Change Due 
Date/APPTIME Data 
option.
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Note:
The Change Due Date/APPTIME Data option of Supplement LSR sets the 
value of an LSR’s supplement type to 2 (or 4 in the AT&T Southeast Region).

5. If you need to modify a desired due date, type the new date in the DDD 
and/or DDDO fields. 

6. If you need to modify appointment data, type the new date 
(APPTIMEDDD) and/or response identifier (RESID) (AT&T 12-State 
Regions). 

7. If applicable, type any comments to be sent to AT&T in Remarks.

8. From the Actions menu, select Close Edit.
LEX displays a message for you to confirm that you want to save your changes 
and set the LSR back in view-only mode.

9. Click OK.

10. If the LSR is ready to be reissued, select Issue from the Actions menu. 
See Issuing LSRs in this chapter for more information.

Version is 
incremented.

Status is New.
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Canceling an LSR
The Cancel option of Supplement LSR allows you to notify AT&T that work 
requested on a previously issued LSR is no longer required. LSRs awaiting 
response from AT&T OSSs can be canceled, but LSRs not awaiting response from 
AT&T OSSs cannot be canceled. Instead, they must be deleted using Delete on 
the Actions menu. For step-by-step deletion instructions, see Deleting an LSR in 
this chapter.

Note:
Complete Status: Only Requisition Type J LSRs or LSRs with Activity Type R can 
be deleted while in Complete status. All others must reach Post to Bill status 
before they are eligible for deletion. See “Deleting LSRs,” “Delete LSR and LSR 
statuses” for details.

1. Search for and select an LSR with a status of Issued, Processed, 
Jeopardy, or FOC.
For detailed search instructions, see Using LEX’s Search Option in this chapter.

2. From the Actions menu, select Supplement LSR.
LEX presents the Supplement LSR dialog.

LSRs with these statuses 
must be canceled:

LSRs with these statuses 
must be deleted:

Issued
Processed
Jeopardy
FOC

New
Worked
Complete
Post to Bill
Billing Completion Notice
Fatal Error
Super Fatal
Supplement
Cancel FOC
AT&TCancel
Template
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3. Click the Cancel option.
The system displays a confirmation message.

4. Verify that the correct PON is displayed and click OK. If the PON is 
incorrect, click Cancel to discontinue canceling.
LEX copies all data from the LSR (excluding notification data) to a new version. 
LEX updates the LSR Header, setting Status to New and incrementing the LSR’s 
version number. This new version is automatically saved and reissued to AT&T 
OSSs. For the AT&T Southeast Region, LEX places the new version in edit mode 
should the user choose to edit the REMARKS section. The user must then close 
out of edit mode and Issue the LSR. Once the cancellation is received by the 
OSSs, the status of the new version becomes Cancel FOC. Although canceled, all 
previous versions of the LSR are retained for future reference until you or another 
user chooses to delete them.

Note:
The Cancel option of Supplement LSR sets the value of an LSR’s supplement 
type to 1.

Note:
For the AT&T Southeast Region, for Supplement Type 1, the REMARKS field is 
editable, if needed, prior to submission of the LSR for cancellation.

Click the Cancel option.
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Processing LSR Errors

This section discusses how to correct errors returned by downstream Operational 
Support Systems (OSSs). When you process errors on an existing LSR, LEX 
creates a new version of the LSR. You then edit this version, correcting the fields 
in error so that the LSR can be reissued.

About error processing
By selecting Process Errors from the Actions menu, you can correct the errors 
for an LSR. LEX displays two types of error statuses: Fatal Error and Super Fatal. 
These error statuses on an LSR represent LSRs that have been returned to LEX 
from AT&T OSSs. The OSSs provide LEX with the error code and error message 
of each error, and when available, form name, field name, and line number.

When you process errors, LEX sets the original LSR’s status to Worked and 
creates a new version of the LSR. The new version has a status of New and is 
placed in edit mode so that you can make corrections. If the error is a Fatal Error, 
the Supplement Type (SUP field) is set to 3. If the error is a Super Fatal error, 
LEX does not assign a value to Supplement Type on the new LSR version. 

To help you locate errors, LEX highlights erred tabs and fields in yellow, if 
enough information is provided by the downstream OSS. LEX relies upon the 
downstream OSS to pass details about the field that caused the edit error, 
including form name, field name and line number. If LEX doesn’t receive this 
information, it cannot determine the location of the error. Sometimes an error is 
related to more than one field or is at the LSR level. In these situations, LEX 
cannot provide highlights because there’s not a single tab or field to highlight.

Note:
Not all downstream OSS edits will provide form name, field name, and line num-
ber. If you receive errors on an LSR that you don’t know how to correct, contact 
your Local Service Center representative.

Note:
In the AT&T Southeast Region, Clarifications are returned as Super Fatal Errors 
and Rejects are returned as Fatal Errors.
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Warning:
 An LSR may pass initial edits and be rejected by an LSC representative or 
downstream OSSs later in the process. If this occurs, the LSR status will change 
from Processed to Fatal Error. 

Processing errors on an LSR

1. Search for and select the LSR for which you want to process errors.
For detailed search instructions, see Using LEX’s Search Option in this chapter.

2. From the Actions menu, select Process Errors. 
The Process Errors confirmation message displays.

3. Click OK to continue. Otherwise, click Cancel.
LEX copies all data from the LSR (excluding notification data) to a new version 
and places it in edit mode. Data in the LSR Header is updated. Status is set to 
New and the LSR’s version number is incremented. For example, if you processed 
errors on the first version of an LSR, the new version would be version 2. The 
status of the original LSR is set to the status Worked. 
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In the LSR Tree, forms and sections with errors are highlighted so that you know 
what areas require attention. When you click one of these forms or sections, it’s 
opened in the LSR Workspace. There, fields that need correction are highlighted, 
as described in the previous section, About error processing.

4. Click each highlighted form or section in the LSR Tree and correct the 
errors it contains. 

5. If you want to review the errors that were returned on the LSR, select 
View Errors from the View menu. When you’re ready to make more LSR 
corrections, maximize the LEX Desktop window.

Status changes to Worked.

When a form or 
section containing 
errors is 
displayed in the 
LSR Workspace, 
the fields in error 
are highlighted. 
In this example, 
the circled fields 
have errors. 
(DDD, SC, and 
CC) 
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You may view all errors while working on PON corrections. Selecting View 
Errors from the View menu opens the View Errors browser window. This 
window lists all the errors that have been returned on the previous version of the 
selected LSR and includes the error code, line number, error message, field name, 
and form name of each error. You can leave the View Errors window open while 
processing so that you can alternate between the list of errors and the LEX 
Desktop window. 

Note:
View Errors is available as long as you’re processing errors. Once you finish pro-
cessing errors, the View Errors option is disabled. View errors, instead, by click-
ing the Error notification on the LSR Tree. See “Viewing an LSR’s errors” for 
more details.

6. While editing the LSR, delete optional forms if necessary.
See Clearing Optional Forms in this chapter for step-by-step instructions.

7. From the File menu, select Close Edit and save your changes when 
prompted.
Verify you’ve made all necessary corrections. When you close edit mode, 
highlights will be removed from all fields in error. To again check the fields in 
error after you close edit mode, click the Error notification on the LSR Tree.

8. Once you’ve made all changes necessary to correct the LSR, reissue it, 
selecting Issue from the Actions menu.

Printing errors
While processing errors, you can print a list of errors that have been returned on 
an LSR using the View Errors option on the View menu. 

Note:
LEX reports are printed using landscape orientation. Be sure your browser has 
been set up to print in landscape mode. For more information, see “Setting your 
browser to print landscape” later in this chapter.

1. From the View menu, select View Errors.
The View Errors browser window opens, listing all errors that have been 
returned on the selected LSR. 
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2. Click the Print tab.
A new browser window is opened, showing a preview of the report that will be 
printed. The errors are listed in the same order as displayed in the View Errors 
window.
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3. From the File menu, select Print.
All print functionality is provided by the browser you’re using. If you’re using 
Microsoft Internet Explorer, the Print dialog box opens. Using this box, you can:

 Select a printer.

 Designate the number of copies to print. 

 Specify a page or page range to print.

For more information about your browser’s print capabilities, consult its online 
help system.

4. Click OK to send the printout to your printer.
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Printing LSRs

Using LEX, you can print copies of LSR forms, LSRs located by a search, and the 
errors and provider notifications you’ve received. LEX also allows you to print 
the contents of the LSR Workspace and to print out the field content on any given 
form, tab, section, or notification.

The printing of forms and the LSR Workspace are discussed in subsequent 
sections: Printing your LSR forms and Printing the LEX Desktop. For instructions 
on how to print search results, errors, or provider notifications, see:

 Using LEX’s Search Option

 Processing LSR Errors

 Printing Provider Notifications

Setting your browser to print landscape
LEX reports are landscape oriented. This means that printouts are wider than the 
standard 8.5-inch page width of portrait orientation. For this reason, you’ll want to 
set your browser to landscape orientation, as your browser controls all print 
functionality within LEX including page orientation and margins. 

Note:
The following instructions are based upon Microsoft Internet Explorer.

1. Maximize the browser window from which LEX was launched by 
clicking the Web LEX- Microsoft Internet Explorer button on your 
Windows taskbar.

2. From the File menu, select Page Setup.

Click the Web LEX- Microsoft Internet Explorer 
button on your Windows taskbar to maximize the 
browser window.
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3. In the Orientation box of Page Setup, click Landscape.

4. Click OK to save the change.
This change applies only to browser windows launched by LEX print commands. 
It does not affect any other instances of your browser, including any other 
instances of LEX that might be running at the same time. In addition, this change 
is for the current login session only. The next time you log into LEX, you’ll want 
to reset your browser to use landscape orientation by repeating this procedure.

5. To continue working in LEX, maximize the application by clicking the 
LEX - Microsoft Internet Explorer button on the Windows taskbar.
  

Selecting Page Setup 
from the File menu opens 
the Page Setup window.

Click Landscape.

Click the LEX- Microsoft Internet 
Explorer button on your Windows taskbar 
to maximize the LEX browser window.
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Printing your LSR forms
The Print Forms option, available on the File menu, allows you to print all forms 
associated with the selected LSR.

Note:
LEX reports are printed using landscape orientation. Be sure your browser has 
been set up to print in landscape mode. For more information, see “Setting your 
browser to print landscape” in this chapter.

Note:
If the user receives an error message that a more current status of the LSR is 
available, the user should refresh the screen, have the current LSR retrieved, and 
print that current LSR.

1. Search for and select the LSR or template whose form(s) you want to 
print.
For detailed search instructions, see Using LEX’s Search Option in this chapter.

2. If you’ve placed the LSR in edit mode, save any changes you’ve made. 
Then, select Close Edit from the Actions menu.
The Print Forms option is not available while an LSR is in edit mode.

3. From the File menu, select Print Forms.
LEX displays the LSR forms you can print. The list of forms is based on the 
LSR’s Service Type and Activity Type.

4. Choose the form(s) to print by marking the corresponding check boxes. 
If you want to print all the forms, check Select All. Then, click OK.

Click the check boxes of 
the forms you want to 
print. 

To print all the available 
forms, check Select 
All. 
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A new occurrence of your browser window is opened, showing a preview of the 
report that will be printed. 

5. From the File menu, select Print.
All print functionality is provided by the browser you’re using. If you’re using 
Microsoft Internet Explorer, the Print dialog box opens. Using this box, you can:

 Select a printer.

 Designate the number of copies to print. 

 Specify a page or page range to print.

For more information about your browser’s print capabilities, consult its online 
help system.

6. Click OK to send the report to your printer.
If you’d like to save a copy of the report, follow the instructions in the next 
section, Saving your LSR forms to file.
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Saving your LSR forms to file
You can also use the Print Forms option to save all forms associated with the 
selected LSR. This allows you to refer back to electronic copies of LSRs you’ve 
created or e-mail them to co-workers via an electronic mail package on your 
computer.

1. Search for and select the LSR or template whose form(s) you want to 
save.
For detailed search instructions, see Using LEX’s Search Option in this chapter.

2. If you’ve placed the LSR in edit mode, save any changes you’ve made. 
Then, select Close Edit from the Actions menu.
The Print Forms option, used to save your forms, is not available while an LSR 
is in edit mode.

3. From the File menu, select Print Forms.
LEX displays the LSR forms you can print and save. The list of forms is based on 
the LSR’s Service Type and Activity Type.

4. Choose the form(s) to save by marking the corresponding check boxes. 
If you want to print all the forms, check Select All. Then, click OK.
A new occurrence of your browser window is opened, showing a preview of the 
forms you’ve selected. 

Click the check boxes of 
the forms you want to 
save. 

To save all the available 
forms, check Select 
All. 
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5. From the File menu, select Save As.

6. Select a location to save the file, including disk drive and folder.

7. Type a name for the file to be saved.

8. Select the file type HTML File to include the text formatting and page 
layout in the file.
If you select a text-only format, the text formatting and page layout will not be 
saved. Only the words and punctuation will be saved.

9. Click Save.
The file is saved to the location you specified. 

To open the saved file, open Windows Explorer. Locate and double-click the file. 
Your Web browser software is automatically launched and the file is displayed in 
the browser window.
Proprietary - Not for use or disclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities
of this AT&T Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and AT&T Inc. Additional or external use is strictly prohibited. 
© 2002-2006. AT&T Knowledge Ventures. ALL RIGHTS RESERVED. 

5.73



Processing Local Service Requests
Printing LSRs5
Printing the LEX Desktop    
Using features provided by the Windows environment, you can print the screen as 
it looks in LEX. You copy the LEX desktop to the Windows clipboard, an internal 
temporary storage area. Then, you can paste it in a word processor (e.g., Microsoft 
Word) or image editing application (e.g., MS Paint) of your choice. You will 
need to be familiar with the application’s paste, save, and print options. If you 
need assistance with these tasks, refer to the application’s printed documentation 
or online help for specific instructions.

Note:
Be sure to change your printer setup from portrait to landscape before completing 
the steps below. See “Setting your browser to print landscape” for instructions.

1. Locate and open the LSR you want to print.

2. Select the form, tab, section, or notification you want to print.

3. Using your keyboard, hold down Alt while pressing Print Screen to copy 
the screen image to your Windows clipboard.
Typically, the Alt keys are located on either side of the Space Bar. The Print 
Screen key is generally found towards the upper, right-hand side of the keyboard. 
On some keyboards, the Print Screen key will be labeled differently. Key labels 
and locations will vary according to keyboard manufacturer.

4. Open the application you will use to print the LEX Desktop image. If the 
application is already open, maximize it.

5. Using the application’s edit tools, paste the image into a document.
For example, if you were to paste the image into a Microsoft Word document, you 
would select Paste from the Edit menu. Refer to the application’s documentation 
or online help for specific instructions.

6. Save the document.

7. Use the application’s print tools to send the document to your printer. 
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Changing Regions of Operation

LEX provides a mechanism for users to manage LSRs in multiple operating 
regions. The Change Region view option allows a user to work with LSRs in 
one region, and when finished, switch to a different region for managing LSR 
data. Change Region, however, is only available to users who possess multi-
region user IDs. If your user ID has been defined with privileges to access two or 
more different operating regions, the Change Region option is available to you. 
Contact your Account Manager to secure the appropriate form to have a multi-
region user ID set up.

AT&T Region Companies in the Region
AT&T Southwest Region AT&T Arkansas 

AT&T Kansas
AT&T Missouri
AT&T Oklahoma
AT&T Texas

AT&T West Region AT&T Nevada
AT&T California

AT&T Midwest Region AT&T Illinois
AT&T Indiana
AT&T Michigan
AT&T Ohio
AT&T Wisconsin

AT&T Southeast Region AT&T Alabama
AT&T Florida
AT&T Georgia
AT&T Kentucky
AT&T Louisiana
AT&T Mississippi
AT&T North Carolina
AT&T South Carolina
AT&T Tennessee

The AT&T regions of operation and affiliated local exchange companies.
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Changing to a different region

1. From the View menu, select the Change Region option. 
The Select Region dialog opens in the LSR Workspace. Options in the Icon Bar, 
LSR Header, and LSR Tree are disabled until you select a region.

Regions for which your user ID has been granted access privileges are color 
coded. As you move the cursor across the map regions, pop-up text displays the 
states that belong to each region. 

2. Select a region.
You can select a region in one of two ways. Click the button adjacent to a region 
name, or click a region on the map. 

3. Click Submit.
LEX connects to the region’s database. The LEX Welcome displays in the LSR 
Workspace, while the name of the region to which you’re now connected displays 
above Status in the LSR Header. Any secondary browser windows you might 
have had open, such as the Search Results window, are also closed. 
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In some instances, your region of choice may be inaccessible. LEX business hours 
may vary between regions due to holiday and other OSS availability issues. If you 
choose to change to a region that is unavailable as a result of differing business 
hours, LEX will not switch to the region. Instead, it will notify you of the region’s 
inaccessibility by displaying a message. For more information about hours of 
business, see Holiday and other OSS availability in Chapter 2, Introduction. 
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Managing Provider Notifications (AT&T 
12-State Only)

When an end user changes Local Service Providers, a notification is typically sent 
to the original provider. This is referred to as a provider notification. In the case of 
line sharing, provider notifications are also sent when retail TN disconnect or 
move orders are initiated that result in a line share loss or when line share 
telephone numbers are changed. AT&T will also send a provider notification 
when a previous line share provider notification needs to be canceled.

Using the LEX Provider Notifications option on the View menu, you can check 
to see whether any provider notifications have been received for your company. 
You can view a list of the provider notifications onscreen or print the list. The list 
includes the following information with each provider notification:

 Date and Time Sent (D/T Sent)

 Conversion Date of Order (CVD)

 Working Telephone Number Lost (WTN)

 Exchange Company Circuit ID (ECCKT)

 Notification Type (NT)

 Notification Type Activity (NTA)

 Response Days (RDY)

 Telephone Number Change (TNC)
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Viewing Provider Notifications

Note:
All provider notifications with a Date Sent greater than two years old are auto-
matically removed from the LEX database during regular monthly maintenance. 
Removed notifications will not be visible.

1. From the View menu, select Provider Notifications.
The View Provider Notifications dialog displays in the LSR Workspace.

2. In Date Sent, enter the date range during which the provider 
notifications you want to view were sent. Or, if you prefer to view a list 
of all provider notifications, do not supply a date range. 
By entering a date range, you tell LEX to filter the list of provider notifications to 
include only those that were sent during the designated timeframe. However, if a 
date range is not provided, LEX does not filter the list. Instead, it displays all of 
the provider notifications currently available in the system for your company. 

If you need help selecting dates, use the Calendar buttons to view the online 
calendar. For more information about using the Calendar, see Entering dates in 
Chapter 2, Introduction.

3. From Select Lines Per Page, select the number of provider notifications 
to appear on each page of the Provider Notification Results window.
The number you select is the maximum number of matching notifications that will 
display in the Provider Notification Results window at one time. As an 
example, the default selection is fifteen, which means LEX will present provider 
notifications in groups of up to fifteen at a time.

Calendar 
buttons
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4. Click Search. 
The Provider Notification Results window opens. It is a browser window 
separate from your LEX browser window. 

This window lists all the provider notifications that were sent to your company 
during the date range you’ve specified. They are presented in date/time order. If 
more provider notifications were found than the per-page selection you made in 
Step 3, navigation links are added to the bottom of the window. Use the navigation 
links to view information, see the next section, Navigating Provider Notifications.

If your company has not received any provider notifications or it did not receive 
any during the specified date range, the window will be empty, except for the 
following message:
“No provider notifications found for your company. Click OK to return to the 
workspace.”

5. If you want to change the sort order, click the up or down arrow in the 
column by which you want to sort.
 Click the up arrow to sort in ascending order.

 Click the down arrow to sort in descending order.
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Navigating Provider Notifications
When the number of provider notifications exceeds the number that can be 
displayed on a single page, LEX adds hyperlinks to the bottom of the Provider 
Notification Results window. The lines-per-page selection you make on the 
View Provider Notifications dialog determines how many provider 
notifications LEX can display on a single results page. Use the hyperlinks, to 
navigate and browse the list of results.

The number of page links visible on the Provider Notification Results window 
depends upon your per-page selection and the number of notifications found. LEX 
retrieves up to 150 matching provider notifications at one time. These are divided 
by the number of lines per page you’ve selected. This means the fewer lines per 
page you choose, the more page links you’ll see. If the located provider 
notifications exceed 150, another set of sequentially-numbered pages is available. 
You advance to the next set by clicking Next. In the illustration above, more than 
10 pages of results are available, although only 10 are visible. Clicking Next, in 
this case, would display page 11 and any other available pages up to page 20. 

This Link Displays This Provider Notification Results Page
First Page 1, regardless of which page you’re currently viewing.
Previous The page immediately before the current page. For example, 

in the following illustration, page 2 is the current page. 
Clicking Previous would display page 1.

Page Number The page that corresponds to the link number. For example, 
clicking 2 displays page 2, while 10 displays page 10.

Next The page that follows the current page. For example, in the 
following illustration, clicking Next would display page 3.

Last The very last page of search results, regardless of which 
page you’re currently viewing.

First goes to Page 1.

Previous and Next move back 
and forth through the results, 
one page at a time.

Page numbers allow you to go 
directly to a specific page.

Last goes to the end 
of the results. 

The number of the current page is bold. Since 
you’re already viewing the page, its number is 
not a hyperlink.
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Sorting Provider Notifications
By default, provider notifications in the Provider Notification Results window 
are sorted by D/T Sent. This creates a list in reverse chronological order. Click 
the down arrow at the top of the D/T Sent column to reverse the sort order.

To change how the provider notifications are sorted, click the up arrow at the top 
of another column. For example, if you want to view the provider notifications in 
ascending conversion date order, click the up arrow at the top of the CVD column. 
Click the down arrow in the same column to view the list in descending order.

Deleting Provider Notifications
LEX allows you to delete provider notifications that are no longer needed. After 
you’ve acted upon a provider notification, use the procedure below to delete it. 

Warning:
Once a provider notification is deleted, it will not be included on future provider 
notification lists.

1. Locate the provider notifications you need to delete using the 
instructions in the previous section, Viewing Provider Notifications.
The Provider Notification Results window opens. 

2. Click the check box next to each provider notification that you want to 
delete. A check mark indicates it is selected for deletion. 

Click the up 
arrow to sort a 
column in 
ascending order.

Click the down 
arrow to sort a 
column in 
descending 
order.
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Or, you can check the Delete All Provider Notifications On This Page check 
box to select all the provider notifications currently displayed onscreen. You can 
then uncheck any that you want to keep. This is especially helpful if you will be 
deleting the majority of the provider notifications, but not the entire list. Provider 
notifications on subsequent or previous pages must be selected and deleted 
independently. 

3. Click the Delete tab.
The system presents a confirmation message.

4. Verify that you’ve selected the correct notifications. If they’re correct, 
click OK to continue. Otherwise, click Cancel to return to the selection 
dialog.
LEX deletes the provider notifications from the database, and you’re returned to 
the Provider Notification Results window.

In the Delete column, click the 
check boxes of the provider 
notifications to be deleted.

With provider notifications selected 
for deletion, click the Delete tab to 
remove them from the list.
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Saving Provider Notifications
Once you’ve located a series of provider notifications, you can save them to a file 
(export) for use in other applications, such as Microsoft Excel®. All provider 
notifications that result from a search are exported to the file, including those that 
span several screens due to the per-page limit. Only the data you see in the 
Provider Notification Results window is exported to the file (e.g., D/T Sent, 
CVD, WTN, etc.). 

Consult the online help in the application in which you will use the provider 
notification data for instructions about sorting or any other issues regarding the 
saved file. 

1. Locate the provider notifications you want to save using the 
instructions in Viewing Provider Notifications.
The Provider Notification Results window opens. 

Note:
If your provider notification results include more than 10,000 provider notifica-
tions, the time required to save the data can be extensive. You may want to select a 
date range of shorter duration to limit the number of provider notifications 
returned.

2. Move your cursor to Save As to display the available file types.
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3. Click the type of file you want to create: Text, CSV, or Excel.
 Text: Saves the file in text-only format (ASCII), separating columns with 

spaces.

 CSV: Saves the file in comma-separated-value format, separating columns 
with commas.

 Excel: Similar to CSV, but this format is specifically designed for use with 
Microsoft Excel.

The File Download window opens.

When you place the cursor on Save As, the options 
Text, CSV, and Excel appear.
Proprietary -
reproduce, cop
of this AT&T 
Resale Agreem
© 2002-2006. 
 Not for use or disclosure outside AT&T Inc. except by prior written agreement. CLECs  may use,
y, and distribute the information solely for internal use in training employees to utilize the capabilities
Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
ent between the CLEC and AT&T Inc. Additional or external use is strictly prohibited. 
AT&T Knowledge Ventures. ALL RIGHTS RESERVED. 

5.85



Processing Local Service Requests
Managing Provider Notifications (AT&T 12-State Only)5
4. Choose the Save option. 
How the options are presented may vary according to the browser version you’re 
using. Pictured above is the File Download dialog box presented by Microsoft 
Internet Explorer version 6.0. The Save As dialog box opens.
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5. Select the folder to which you want to save the file. Then, type a file 
name in the File Name field or click an existing file already in the folder 
and click Save. 
If you selected Text as the file format, you’ll need to type.txt as the file extension 
at the end of the file name. For CSV and Excel files, the extension is implied, so 
you don’t need to type it.

If you type the same name as an existing file, you will be prompted to replace it. 
After your file has been saved, LEX displays the message, “Download 
Complete.”

6. Click OK or Close to accept the message.
If you prefer to view the newly saved file, click Open.

Printing Provider Notifications
Using the Provider Notifications option, located on the View menu, you can 
also print provider notifications. 

Note:
LEX reports are printed using landscape orientation. Be sure your browser has 
been set up to print in landscape mode. For more information, see the section 
“Setting your browser to print landscape” in this chapter.

If your provider notification results include more than 10,000 provider notifica-
tions, the time required for the system to prepare the print job can be extensive. 
You may want to select a date range of shorter duration to limit the number of pro-
vider notifications returned.

1. Locate the provider notifications you want to print using the 
instructions in Viewing Provider Notifications.
The Provider Notification Results window opens, displaying the provider 
notifications that were sent to your company during the specified date range. The 
provider notifications will be printed in the same order as displayed in the 
window. If needed, you can reorder the notifications using the up and down sort 
arrows, as described in Sorting Provider Notifications.
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2. Click the Print tab.
A new browser window is opened, showing a preview of the report that will be 
printed. 

3. From the File menu, select Print.
All print functionality is provided by the browser you’re using. If you’re using 
Microsoft Internet Explorer, the Print dialog box opens. Using this box, you can:

 Select a printer.

 Designate the number of copies to print. 

 Specify a page or page range to print.

For more information about your browser’s print capabilities, consult its online 
help system.

4. Click OK to send the printout to your printer.
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Viewing LEX Tips

LEX Tips is a communication tool through which AT&T may provide additional 
information to your company about the LEX application. Tips are relevant, but 
non-essential, non-critical bits of information. They may be helpful hints about 
how to use the system or system advice not yet published in this user guide. 

The feature is always available. At any time, you may access the LEX Tips 
window to see what tips AT&T has added or removed. (AT&T will remove tips as 
they become outdated.) To ensure you always see the latest information, consider 
establishing a regular schedule for checking tips, such as once a day or once a 
week. While viewing tips, you have the option to print one or more for future 
reference.

Note:
AT&T will not provide urgent or time-sensitive information, such as system down-
times or outage details, via LEX Tips. Accessible letters are distributed to commu-
nicate such information.

Viewing the tip list

1. From the Help menu, select LEX Tips.
The LEX Tips window opens.
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The LEX Tips window is a separate browser window, independent of the LEX 
Desktop. The information you see is read-only; you may not modify or delete tips. 
However, you may change the sort order if you desire. By default, tips are 
chronologically organized with the most recent at the top.

2. Change the sort order, if desired, using the up and down arrows at the 
top of any column. 
See Sorting Tips for more information.

3. When you’re finished working with tips, click Exit to close the window.

Sorting Tips
By default, LEX Tips are sorted by the date and time they were provided by 
AT&T. This creates a list in reverse chronological order. Click the down arrow at 
the top of the Date column to reverse the sort order.

If desired, you may change how the tips are sorted. For example, you might want 
to view the tips alphabetically by title to group similar tips. You change the sort 
order by clicking the up or down arrow at the top of a different column, such the 
the Title column. Clicking the up arrow sorts a column in ascending order, while 
clicking the down arrow sorts the column in descending order.

Click the up 
arrow to sort a 
column in 
ascending order.

Click the down arrow to 
sort a column in 
descending order.
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Printing tips
You may also print tips using the LEX Tips option, located on the Help menu. 

1. Open the LEX Tips window using the instructions in Viewing the tip list.

2. Sort the tips in the order you would like them printed. They will be 
printed in the same order as displayed.
For more information, see the previous section, Sorting Tips.

3. Select one or more tips to print.
 To select specific tips, click the check box in the Print column next to each tip 

you want included in your printout.

 To select all the tips displayed, click Select All above the Print column.

4. Click the Print tab.
A new browser window is opened, showing a preview of the tips that will print. 

5. From the File menu, select Print.
All print functionality is provided by the browser you’re using. If you’re using 
Microsoft Internet Explorer, the Print dialog box opens. Using this box, you can:

 Select a printer.

 Designate the number of copies to print. 

 Specify a page or page range to print.

For more information about your browser’s print capabilities, consult its online 
help system.

6. Click OK to send the printout to your printer.
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Miscellaneous Processing LSRs (AT&T 
Southeast Region)

Fast Track Process
An option, known as “Fast Track”, permits the user to submit a minimum amount 
of required fields and LEX will derive the remainder of the fields from different 
sources.

Available for: Requisition Types E and M

Activity Types D, B, W, L and Y

The user will be expected to populate the fields on the LSR Create screen as in the 
normal process of creating any LSR:

After the user enters the applicable information, the user would click on the “OK” 
button.
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The following sequence of events would occur:

 LEX/Verigate will perform a validation of the company code and the main 
account telephone number to confirm ownership and provide an error 
message where applicable on that particular account(s). If the validation is 
successful, LEX will proceed on with the LSR creation.

 LEX/Verigate will perform an address validation on each main account 
telephone number to confirm valid address and provide an error message 
where applicable. If the address validation is successful, LEX will populate 
the applicable address fields on the End User location form.

 LEX will pre-populate all of the applicable fields based upon the CLEC 
profile for the specified company code.

 LEX will present the LSR with all pre-populated fields and allow the user to 
review, modify if necessary, and then issue it to AT&T downstream systems.

Multiple Occurrences of the End User Form

For certain products and scenarios, multiple occurrences of the End User form 
may be needed. LEX allows the user to create up to 999 End User forms within an 
LSR as needed. The associated Disconnect form is also provided for each copy of 
the End User form.

For both the Location and Disconnect forms, LEX provides a counter of the 
number of each form:
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A Num Navigation is provided to allow the user to add LOCNUM as needed. As 
new LOCNUMs are added, the counter next to the form will be incremented.

Note:
Num Navigation allows for LOCNUMs to be added, copied or deleted. Depending 
on the product, the LOCNUM must start with either 00 or 01. Please refer to the 
LSOR for specific rules on the LOCNUM field. Although this field is system gen-
erated, it can be editable by the user, but any user changes to the field will result 
in the LOCNUM numbers not being accurately reflected.
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The Disconnect form is set up in the similar manner as shown below:

Note:
The user will be expected to enter the LOCNUM that the Disconnect form should 
be associated with as it is an editable field. The DNUM will be system generated 
by the use of NUM Navigation.

The user would be expected to complete the first LOCNUM information, then go 
to the Disconnect page and complete that form as associated with the LOCNUM. 
The user would then proceed to create the next LOCNUM, complete the Location 
form, and then go to the Disconnect form and via the LOCNUM field on the 
Disconnect page, indicate the LOCNUM on the Location page that this should be 
associated with.
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When the user clicks on the Disconnect form from the LSR Tree, LEX 
automatically generates the first LOCNUM for the user. When subsequent 
Disconnect forms are generated through NUM Navigation, the LOCNUM field is 
blank and the number is populated by the user. The LOCNUM field on the 
Disconnect form allows the user to indicate what LOCNUM this is associated 
with on the Location form. For instance, if ‘3’ is entered in the LOCNUM field, 
this would indicate that the Disconnect information on this form is associated with 
LOCNUM ‘3’ on the Location form.

The first LOCNUM on the Disconnect form is system generated when the form is 
accessed:

When the second DNUM (or occurrence of the Disconnect form) is created via the 
NUM Navigation, the LOCNUM is blank:

Should the user click on the Disconnect form and determine that the form is not 
needed, the user should remove the number from the LOCNUM field and leave it 
blank. There should be no other entered data on that form.

In the majority of the products being offered, only one occurrence of the End User 
form (Location and Disconnect) will be needed. This capability is being provided 
to allow for those other scenarios that require additional copies of this form.
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Transferring Calls on Disconnected Accounts

For Requisition Types “E” and “M”, Activity of “C”, an addition of a Transfer of 
Call (TOC) message on a Telephone Number that has been disconnected 30 
calendar days or less will be available to be issued within LEX. This option 
should only be used to add or change the Transfer of Calls (TOC) on a 
disconnected telephone and no other changes should be performed on the LSR.
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